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Copyrights | Trademark Notices | Licenses
Copyright © 2025 Telestream 2, LLC and its Affiliates. All rights reserved. No part of this 
publication may be reproduced, transmitted, transcribed, altered, or translated into any 
languages without written permission of Telestream 2, LLC. Information and 
specifications in this document are subject to change without notice and do not 
represent a commitment on the part of Telestream. Specifications subject to change 
without notice.

Telestream, CaptionMaker, Cerify, DIVA, Episode, Flip4Mac, FlipFactory, Flip Player, 
GraphicsFactory, Kumulate, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Switch, 
Tempo, TrafficManager, Vantage, VOD Producer, and Wirecast are registered trademarks 
and Aurora, ContentAgent, Cricket, e-Captioning, Inspector, iQ, iVMS, iVMS ASM, 
Pipeline, Sentry, Surveyor, Vantage Cloud, CaptureVU, FlexVU, PRISM, Sentry, Stay 
Genlock, Aurora, and Vidchecker are trademarks of Telestream, LLC and its Affiliates. All 
other trademarks are the property of their respective owners. 

Telestream products are covered by U.S. and foreign patents, issued and pending. 
Information in this publication supersedes that in all previously published material. 
Specifications and price change privileges reserved.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights 
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the 
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

CoreOS. Developers of ETCD.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby 
Laboratories Licensing Corporation.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology 
licensed from Fraunhofer IIS and Thomson Multimedia.

intoPIX and Fraunhofer. Notice under 35 U.S.C. §287(a): This product or service 
includes JPEG XS compliant features that are covered by patents in the United States 
and in other jurisdictions owned by intoPIX SA (“intoPIX”) and/or Fraunhofer-
Gesellschaft zur Foerderung der angewandten Forschung E.V. (“Fraunhofer”) and listed 
at HYPERLINK http://www.jpegxspool.com. Additional patents may be pending in 
United States and elsewhere.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights reserved.

Built with Llama. Llama 3.1 and Llama 3.2 are licensed under the Llama Community 
License, Copyright © Meta Platforms, Inc. All Rights Reserved. See https://
www.llama.com/llama3_1/license/ and https://www.llama.com/llama3_2/license/.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and 
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.
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MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows Server 2019, Windows Server 2022, Windows Server 
2025, Windows 11, Media Player, Media Encoder, .Net, Internet Explorer, SQL Server 
2019, SQL Server 2022, and Windows Media Technologies are trademarks of Microsoft 
Corporation.

NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT 
License and Apache License is copyright © 2014-2016 by Google, Inc., © 2016 by Stabzs, 
© 2015 by Hiro, Sjoerd Tieleman, © 2016 by Denis Pushkarev, © 2015 by Dash Industry 
Forum. All rights reserved.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer:

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Swagger. Licensed from SmartBear.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

 

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.
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MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream 2, LLC (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if 
any, Telestream is under no obligation to maintain or support the Software and 
Telestream has no obligation to furnish you with any further assistance, technical 
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support, documentation, software, update, upgrades, or information of any nature or 
kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Server Regulatory Compliance
Electromagnetic Emissions: FCC Part 15 Subpart B, ICES-003, EN 55032, EN/BS 55024, 
EN/BS EN 55035, EN 61000-3-2, BS EN 61000-3-2, EN 61000-3-3, BS EN 61000-3-3,  VCCI-
CISPR 32, AS/NZS CISPR 32

Electromagnetic Immunity: EN 55035
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Safety: IEC 62368-1, EN 62368-1, CSA C22.2 No. 62368-1-14, UL 62368-1

Additional Country Certifications: NOM, IRAM S-Mark

California Best Management Practices Regulations for Perchlorate Materials:
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) 
Lithium coin cells. Perchlorate Material-special handling may apply. See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.

Contact Telestream Customer Service for additional Regulatory Compliance certificates.

Contacting Telestream

Resource Contact Information

Telestream Technical 
Support Portal

Web Site: support.telestream.net

Vantage Technical 
Support Portal

Web Site: telestream.net/telestream-support/vantage/
support.htm

Support Email: support@telestream.net

Terms and times of support services vary, per the terms of 
your current service contract with Telestream.

Vantage Information, 
Assistance, FAQs, 
Forums, & Upgrades

Web Site: telestream.net/telestream-support/vantage/
support.htm

General Contact 
Information

Web Site: telestream.net/company/contact-
telestream.htm

Telestream, LLC Web Site: telestream.net

Sales and Marketing Email: info@telestream.net

International 
Distributor Support

Web Site: telestream.net

See the Telestream site for your regional authorized 
Telestream distributor.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document, or other Telestream documents—or if 
you've discovered an error or omission, please email us.

https://www.telestream.net/company/contact-telestream.htm
https://www.telestream.net/company/contact-telestream.htm
https://www.support.telestream.net/
https://www.telestream.net/telestream-support/vantage/support.htm
https://www.telestream.net/telestream-support/vantage/support.htm
mailto:support@telestream.net
https://www.telestream.net/telestream-support/vantage/support.htm
https://www.telestream.net/telestream-support/vantage/support.htm
https://www.telestream.net
mailto:info@telestream.net
https://www.telestream.net
mailto:techwriter@telestream.net
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Setting up Workflow Portal

The Workflow Portal is a Vantage client (implemented as a Windows program and a 
web application) with a user interface that you can customize for your operators to 
include the media processing functions they need. 

This chapter describes how to create Workflow Portal configurations using the Vantage 
Management Console. 

Topics
■ Introduction to Vantage Workflow Portal

■ Workflow Portal Licensing and Deployment

■ Configuring Vantage Workflow Portal

Introduction to Vantage Workflow Portal
Operators use the Vantage Workflow Portal to manage media and manually intervene 
in workflow processing by performing tasks such as browsing catalogs, reviewing and 
updating metadata, marking in/out trim points, and forwarding files to workflows.

Two versions of the Vantage Workflow Portal are available—a Windows client and a 
web application. Both perform very similar functions. The Windows client supports all 
configurations but requires client installation on the Windows desktop. The web 
application supports a limited set of configurations but can be accessed by either Mac 
OS or Windows computers with a web browser.

The controls available in the Workflow Portal and the tasks an operator can perform 
vary according to the Workflow Portal configuration created by a Vantage 
administrator using the Vantage Management Console. Different configurations 
present different features in the Workflow Portal.

In addition, workflow designers must also create ingest and target workflows that 
permit operator intervention in media processing using the Workflow Portal. 

These are the required tasks to complete before operators can use the Workflow Portal:

• An administrator must create Vantage Workflow Portal configurations using the 
Vantage Management Console> Application Configurations > Workflow Portal.
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• A workflow designer must create and activate Ingest workflows (optional in some 
cases) using the Workflow Designer to analyze and flip source media and register 
media, proxies, and attachments into Vantage catalogs. 

• A workflow designer must create and activate target workflows in the Workflow 
Designer to process the media submitted by operators from the Workflow Portal for 
distribution, broadcast, and other uses.

Note: If you are creating a store to hold proxy files viewed in the Vantage Workflow 
Portal, Telestream recommends that you reference the store with a UNC path. Some 
SAN clients do not allow frame-accurate representation of proxies when using shared 
drives.

This chapter describes the work of the administrator to create Workflow Portal 
configurations. Please see the Vantage User Guide for information about configuration 
overviews and applications, designing workflows, and using the Workflow Portal. 

Also note that some configurations enable separately licensed products that have their 
own guides with information for administrators, workflow designers, and operators:

• Vantage TrafficManager User Guide (also covers Syndication)

• Vantage Tempo User Guide

• Post Producer Developer’s Guide, Post Producer Cookbook

Workflow Portal Licensing and Deployment
Each Vantage Workflow Portal license supports a single user or a single computer, 
depending on your Vantage configuration. Under certain conditions, a single user or 
computer can host multiple instances of a license, and these instances are called 
sessions. When a license is in use by a user or a computer, it is unavailable to other users 
or computers. To support multiple users or computers, you must purchase additional 
licenses. The following topics provide additional information on Vantage Workflow 
Portal licensing:

 User-Based Licensing

 Machine-Based Licensing

 Viewing and Resetting Vantage Workflow Portal Sessions

 Workflow Portal Deployment Tips

Note: For information on VWP license management, see Managing Licenses in the 
Vantage Domain Management Guide.

Note: When using the Vantage Workflow Portal desktop application, each session will 
utilize one license seat. For example, with a 5 seat policy if you open three instances of 
the Vantage Workflow Portal desktop application on your machine, this will consume 
three license seats leaving two available. When using the Vantage Workflow Portal 
web application, multiple browser instances can be opened on the same machine but 



Setting up Workflow Portal
Workflow Portal Licensing and Deployment

15

this only consumes a single license seat. For example, with a 5 seat policy if you open 
three browser instances of the Vantage Workflow Portal web application on your 
machine, this will consume one license seat leaving four available.

User-Based Licensing
When Vantage user administration is enabled (see Managing Vantage Users in the 
Vantage Domain Management Guide), each Vantage operator reserves a single Vantage 
Workflow Portal license when starting the program. That operator can open additional 
portal sessions on other computers without reserving additional licenses, provided 
that the operator uses the same user name on all computers. However, no other user 
can use the reserved license until the first operator closes all portal sessions that use 
the first operator’s user name.

Machine-Based Licensing
When Vantage user administration is disabled (see Managing Vantage Users in the 
Vantage Domain Management Guide), a Vantage operator reserves a single Vantage 
Workflow Portal license when starting the program on a computer. That operator or 
other operators can open additional Vantage Workflow Portal sessions on the same 
computer without reserving additional licenses. However, no other computer can use 
that license until all sessions are closed on the first computer.

Viewing and Resetting Vantage Workflow Portal Sessions
When a license is in use by a user or a computer, it becomes unavailable to other users 
or computers. If another license is needed, try one or more of the following:

• Reset all sessions for a license that is now idle due to a lost network connection or 
sudden program termination.

• Reset all license sessions for a lower priority user or computer to make a license 
available for a higher priority user or computer.

• Purchase more licenses.
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To view the Vantage Workflow Portal license and session usage, select Licenses in the 
components panel, and click on the Portal Sessions tab to see the following panel:

The Portal Sessions list displays a row for each portal session in use. When user 
administration is enabled (see Managing Vantage Users in the Vantage Domain 
Management Guide), a single Vantage user can open multiple Vantage Workflow Portal 
sessions, and each session is represented by a row in the session list. When user 
administration is disabled, a single computer can host multiple portal sessions, and 
each session is represented by a row in the session list. 

When user administration is enabled, the User column displays the username of the 
operator using a license session. When user administration is disabled, the Machine 
column displays the computer name of the computer that is using a license session.

The Status column displays Licensed when the session is using a valid license, and it 
displays Demo when the session is unlicensed and open in demo mode.

To reset a license session for a user or computer, select the session and click Stop . 

Workflow Portal Deployment Tips
Vantage administrators can help operators get started by doing the following:

• Install the Vantage Workflow Portal program on the operator’s computer.

• Launch the Vantage Workflow Portal for the first time and pre-select the following:

– Vantage domain

– Vantage Workflow Portal configuration

– Binder catalog

Note: If you deploy the web version of the Workflow Portal, please note that 
operation of the web Workflow Portal preview player may vary depending on the 
browser. The functioning of controls, appearance of captions, and other aspects 
depend on the browser’s implementation of the web video player. You may want to 
try different browsers to find the one that works best for you.
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Configuring Vantage Workflow Portal
As a Vantage domain administrator, you can create and configure Vantage Workflow 
Portal configurations that control which portal features an operator can use. At least 
one configuration is required to make the Workflow Portal functional, but you can 
create as many portal configurations as your operators need.

The following topics describe the Workflow Portal and how to use it: 

 Workflow Portal Overview

 Creating and Editing Workflow Portal Configurations

 Selecting a Configuration Mode

 Using the Tabs
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Workflow Portal Overview
Portal configuration is performed by opening the Vantage Management Console and 
selecting Application Configurations > Workflow Portal panel.

The top half of the Workflow Portal panel is the same for all configurations. It includes a 
toolbar for creating, deleting, saving, importing, and exporting configurations. 

Below the toolbar is a Configuration list showing the configurations that have been 
created and saved. You can use this list to select and modify an existing configuration.

In the center area, selections are provided for the Mode, which selects the 
configuration, fields for naming and describing the configuration (as shown in the list), 
and selectable parameters relating to how the portal operates.

The tabs in the lower panel select and deselect portal features. The tabs vary with the 
selected configuration. Some of the tabs contain the same selections across all 
configurations, while others are specialized depending on the configuration:
 

The remainder of these topics explain the portal configuration controls in top to 
bottom order, beginning with using the top half of the page to create a configuration, 
details of how and why to select each configuration Mode and how to configure their 
specialized tabs, and lastly, the generic tabs common to most or all configurations.

Configuration List Name, Description, Mode 
(configuration), & Parameters

Tabs (vary by 
configuration)

Select Workflow Portal Toolbar



Setting up Workflow Portal
Configuring Vantage Workflow Portal

19

Creating and Editing Workflow Portal Configurations
The following topics explain how to use the portal configuration controls:

 Creating a New Configuration

 Setting Dropframe or Non-dropframe Duration

 Pass Username As

 Modifying a Configuration

 Deleting a Configuration

 Saving a Configuration

 Duplicating a Configuration

 Exporting and Importing Configurations

Creating a New Configuration
To create or edit a Vantage Workflow Portal configuration, do this:

1. Start the Vantage Management Console and connect to the Vantage domain.

2. Select Application Configurations > Workflow Portal to display the Workflow Portal 
panel. 

3. To create a new configuration, click the Create configuration button  in the tool 
bar (or right-click in the empty configuration list space). 

4. Select New Configuration in the top toolbar. 

5. Select the Mode (configuration) in the middle section. (For details about 
configurations, see Selecting a Configuration Mode later in this chapter.)

6. Enter a Name and Description matching the selected Mode. 

7. Make use dropframe and Pass username selections (explained below).

8. Make tab selections (see Selecting a Configuration Mode and Using the Tabs). 

9. To save your configuration, click the Save button . The new configuration is 
added to the Configuration list at the top.

Setting Dropframe or Non-dropframe Duration
Some Workflow Portal configurations display media durations. The duration timecode 
can be dropframe or non-dropframe, depending on the setting of the Use dropframe 
notation for duration when appropriate check box in the Vantage Management Console 
Workflow Portal Configurations panel. By default (unchecked), durations are always 
shown in non-dropframe. When checked, durations match the dropframe setting of the 
in/out values. (The web Workflow Portal uses non-dropframe notation only.)

Pass Username As
The Pass Username As feature allows you to set the username of the portal operator as 
a variable that you can use in workflows. This can be helpful, for example, if you want to 
address a message to a particular operator based on the results of a workflow.
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Modifying a Configuration
To change a configuration, select it in the Configuration list and make any desired 
changes. Click Save when finished to save your configuration updates.

Deleting a Configuration
To delete a Vantage Workflow Portal configuration, do this:

1. Select the configuration to delete.

2. Click the Delete button  in the tool bar.

3. Click OK to confirm the delete or click Cancel to abort the delete.

Saving a Configuration
You can change a configuration by selecting it in the list and modifying your selections 
and entries. To save the configuration changes, click the Save button  in the tool bar.

Duplicating a Configuration
If you need a new configuration that is similar to an existing configuration, it might be 
easier to duplicate the configuration and modify the duplicate, instead of creating a 
new configuration. When you duplicate a configuration, the console creates a new 
configuration with Copy of prepended to the source configuration name.

To duplicate a Vantage Workflow Portal configuration, select the configuration to 
duplicate, and click the Duplicate button  in the tool bar.
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Exporting and Importing Configurations
Vantage allows you to export one or all Vantage Workflow Portal configurations to XML 
files, which you can then use to import the same configurations into another Vantage 
domain.

Export
To export one or all configurations, do this:

1. If you are exporting a single configuration, select the configuration to export.

2. Click the Export button  to export a single configuration, or select Export all from 
the Export button menu to export all configurations.

3. Use the file system dialog to save the exported configurations.

The default file name for each configuration is the configuration name, but you can 
change the file name.

Note: Changing the name of the XML file does not change the name of the 
configuration in the XML file.

Import
To import a configuration, do this:

1. Click the Import button .

2. Use the file system dialog to locate and select the configuration to import, then 
click Open.

Note: If you try to import a configuration that is already in this Vantage domain, 
Vantage prompts you to overwrite the record (click Yes) or cancel the import (click No).

Refreshing the Configuration List
The configuration list is a static display that is automatically updated when you add or 
delete configurations. However, if other administrators add or delete configurations, 
their changes appear only when you refresh the configuration list by clicking the 
Refresh button  in the tool bar.
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Selecting a Configuration Mode
Configurations selected using the Mode drop-down menu customize portal operation 
to fit the kind of workflow processing operators will do. 

The available Mode configurations are summarized briefly below and linked to the 
topics describing them and their setup tabs in detail. Some configurations have 
dedicated tabs with special selections (Tempo, Syndication, Logging) while others use 
generic tabs. 

 Browse Catalogs (Copy Binder) Mode—Allows browsing catalogs and binder copies 
to view, update, and submit media, metadata, and variables to workflows. Original 
binders are unaltered and modified copies are forwarded.

 Browse Catalogs (Forward Binder) Mode—Allows browsing catalogs and original 
binders to view, update, and submit media, metadata, and variables to workflows. 
Original binders are modified and forwarded.

 Browse Windows Network (Create Binder) Mode—Allows selecting media files from 
servers on a Windows network and submitting them to target workflows.

 Create EDLs from Catalogs (Create Binder) Mode—Enables you to create an Edit 
Decision List (EDL) which you submit to a publishing workflow to process the EDL.

 Create CML from Catalogs (Create Binder) Mode—Allows creating a CML file that 
defines an EDL for submitting to a Post Producer publishing workflow.

 Create DPP from Catalogs (Create Binder) Mode—Used in our Digital Production 
Partnership (DPP) product for producing television program packages, ready for 
broadcast or distribution.

 Create VOD from Catalogs (Create Binder) Mode—Used with VOD Producer DAI, for 
producing VOD assets, with optional provisioning for dynamic ad insertion.

 Tempo Re-time Asset from Catalogs (Create Binder) Mode—Used in Tempo to 
adjust media runtime.

 Syndication Mode—Manages TrafficManager ingest and processing of long and 
short-form syndicated broadcast content (multi-segment material).

Note: Some configurations are for features that require separate licensing. All 
configurations are available in the desktop application, but only the Copy Binder and 
Forward Binder configurations are available in the web Workflow Portal. 

How to set up each of the configuration modes and their specialized tabs (if any) is 
described in detail on the following pages and linked above. (For details about the 
generic tabs present in most configurations, see Using the Tabs.) As you read about each 
configuration, remember the definitions of catalogs and binders—catalogs organize 
binders, and binders organize media and attachments produced by ingest workflows. 
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Browse Catalogs (Copy Binder) Mode
This configuration mode (see the figure below) enables an operator to browse the 
selected Vantage catalog for binders. They can then select one binder, and submit it to 
one or more workflows. When the submission occurs, the original binder is copied, and 
the copy is submitted to the workflow—the original binder remains in the catalog and 
remains unchanged.

Note: A binder contains metadata labels, and references to media files and 
attachments. When a binder is copied, the metadata labels are also copied and thus 
may be different from the original. Any media files or attachments in the original 
binder are not copied, and are referenced by both the original and the new copy.

The Browse Catalogs configuration is ideal when:

1. You want the original binder to remain in the catalog

2. You do not want to change the original binder's metadata

3. The original media files are not affected by the target workflow, and

4. You want operators to be able to submit the same asset multiple times.

Target Workflow Considerations
The target workflow must include a Receive action. Remember that any media files or 
attachments present in the original binder will also be referenced in the copy. As a 
result, the target workflow should not delete any of those original files; the original 
binder would then have missing files.

Example Workflows
• Operator marks an in point, and an out point for a highlight; multiple highlights can 

be extracted from the same input.
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• Operator marks trim points around a promo from a captured satellite feed, and 
marks a branding entry point on the timeline; the target workflow then trims the 
promo and applies graphics for multiple distribution channels.

Browse Catalogs (Forward Binder) Mode
This configuration mode (see the figure below) enables an operator to browse the 
selected Vantage catalog for binders. The operator can select a binder, and either edit 
its metadata, or submit it to one or more workflows. When the submission occurs, the 
original binder is forwarded to the workflow (and optionally removed from the catalog, 
if configured that way by the administrator).

Note: Because the binder is directly affected by the target workflow, if the binder 
remains in the catalog, any changes to the binder will appear in the catalog as the 
workflow processes media files.

The Browse Catalogs (Forward Binder) configuration mode is ideal when:

• You want to use the catalog as a task list for the operator, automatically removing 
binders from the catalog when they are forwarded

• You want the workflows to update binders that remain in-place in the catalog

• You want operators to edit metadata in-place.
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Target Workflow Considerations
The target workflow must include a Receive action. Remember that if the binder is not 
removed from the catalog, any changes made by the target workflow will be apparent 
in the catalog.

Example Workflows
• Operator reviews an asset, marks it as approved/rejected, and forwards to a work-

flow that responds to that metadata. The asset is removed from the catalog.

• An ingest workflow detects quality issues and places an asset in a catalog for 
review. An operator reviews the asset, using a proxy to review the video at error 
timecodes published by the ingest workflow. If the asset is unacceptable, the oper-
ator forwards to a workflow for quarantine; otherwise the operator forwards to the 
appropriate next step for the asset.

• Operator edits asset metadata in-place in the catalog. When the asset is ready for 
distribution, the operator chooses distribution channels and forwards to the target 
workflow. The target workflow responds to the operator choices and forwards for 
distribution.

• Operator reviews black segments detected by Vantage, and confirms black removal 
points. The target workflow uses those timecode parameters to remove black from 
the original media.
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Browse Windows Network (Create Binder) Mode
If a project requires operators to browse network locations to locate files to submit to 
workflows, they should use the Browse Windows Network configuration mode (see the 
figure below). As discussed previously, this configuration mode allows multiple files to 
be submitted simultaneously. Each submitted file becomes a separate job with its own 
binder. During submission, the operator can add metadata labels (as permitted by the 
Vantage Workflow Portal configuration). For a batch submission (of multiple media 
files), each media file receives a copy of the same metadata label in its binder:

The Browse Windows Network (Create Binder) Mode is appropriate when:

• Operators manually submit files instead of copying files to a hot folder.

• No ingest workflow is required before operator involvement.

To select the Browse Windows Network configuration mode, do this:

1. Display the Workflow Portal configuration panel as described in Creating and 
Editing Workflow Portal Configurations.

2. Click the Browse Windows Network (Create Binder) radio button.

3. Click the Save button  to save your changes.

Media files are submitted directly, so there is no ingest workflow. However, submitted 
media files must be accessible to Vantage services. For example, files on a local drive 
(for example, C:\media\myvideo.mpg) are not accessible to a remote Vantage server.

The target workflow must include a Receive action. Each media file is assigned the 
nickname Original when it is submitted.
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Create EDLs from Catalogs (Create Binder) Mode
This configuration mode changes Vantage Workflow Portal operation to include a tab 
that enables an operator to stitch assets using an EDL (edit decision list). An operator 
can use the EDL to stitch multiple assets in the catalog together or to trim a clip. 

The EDL is stored in a TSEDL file, which can be stored with other media files in a 
Vantage store or folder, or it can be stored in a special Vantage store or folder, 
designated for EDL files. (For more information, see Using the Storage Tab.)

After an operator has created an EDL, the operator can forward that EDL to a target 
workflow to create the output defined by the EDL. To support EDL processing, you must 
modify the configuration to support forwarding to a workflow that contains a Receive 
action: 

For more information, see Using the Forward to Workflows Tab.

Target Workflow Considerations
The target workflow must include a Receive action. It will receive a TSEDL file with the 
nickname Original and can then transcode—or direct convert—this list into an output 
file (or multiple output files). 

Note: If MPEG-2 is the EDL source format, a Direct Convert mode can be used to avoid 
a full transcode. Any timeline cut that breaks GOP structures is replaced with I-Frame 
material, otherwise original GOPs are preserved. If the output file is not MPEG-2, a full 
transcode can be performed. In either case, the VANC, captions, and audio are 
correctly stitched during the processing of the EDL.

Example Workflows
• Operator creates a list of syndication segments that are stitched together into a sin-

gle program.
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• Operator selects a bumper, a clip, and a trailer, enters metadata, chooses distribu-
tion channels, and submits the package for distribution. The target Vantage work-
flow uses distribution channel choices and metadata to generate the correct 
formats and deploy to the chosen distribution channels.

Catalog Mode Considerations
Assets must be registered into a Vantage catalog using an ingest workflow before they 
will become visible in the catalog and available for use in a target workflow. A 
thumbnail image and a QuickTime H.264/AAC MOV or x264/AAC MP4 proxy file should 
also be registered in the binder and given the nicknames Vantage Thumbnail and 
Vantage Proxy, respectively.

For Create EDL from Catalogs mode, EDL processing requires Program Stream or 
Transport Stream MPEG-2 video, and such a file should be provided in the binder with 
the nickname Vantage EDL. Vantage provides support for MXF DV, IMX, and XDCAM HD 
video formats as well.

Note: All assets in the EDL list must have the same frame size and frame rate; 
operators are not allowed to combine mixed media.

Create CML from Catalogs (Create Binder) Mode
The Create CML workspace displays in the Workflow Portal window when a Create CML 
from Catalogs configuration mode is selected. Using this workspace to create a Post 
Producer composition, an operator can mark start and end points to clip one or more 
media files, and stitch the clips together.

As with the Copy Binder and Forward Binder configurations, the Create CML 
configuration allows users to open and view binders for completed workflows. The 
Create CML configuration allows creating a Composition (CML) file to submit to a Post 
Producer workflow with a Conform action, which can process the composition and 
stitch the clips together. As the administrator, you must select catalogs, labels, 
variables, workflows, binders, and storage to use with this configuration.



Setting up Workflow Portal
Configuring Vantage Workflow Portal

29

For operational details, refer to the Using Create CML Configurations topic in the Using 
Workflow Portal chapter of the Vantage User Guide.

Create DPP from Catalogs (Create Binder) Mode
The Create DPP from Catalogs configuration mode (see the figure below) applies to 
users who are involved in the creation of DPP packages. This configuration allows users 
to do this:

• Create a DPP program containing one or more segments.

• Enter DPP metadata to accompany that program.

• Create a DPP 4.1 XML file and a Post Producer CML file to allow the construction of 
the program media file (using Post Producer) and transcoding to AS-11 with DPP 
metadata (using Vantage Transcode Pro):
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As the administrator, you will need to prepare the DPP portal configuration, assign 
permitted users, select a catalog for viewing media, and select workflows, binders, and 
storage. Additionally, the administrator can specify the default and allowed values for 
the DPP metadata fields, and can control which fields the operator can edit.

For details of administration and operation, refer to the Using Create DPP Configurations 
topic in the Using Workflow Portal chapter of the Vantage User Guide. Also refer to the 
Creating DPP Packages in Vantage App Note.
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Using the DPP Metadata Tab
Using the DPP Metadata and DPP Options tabs, available when the Create DPP from 
Catalogs (create binder) option is selected, you can specify DPP metadata to be 
included in DPP processing. Many fields are available in the Editorial, Technical, Audio, 
Access Services, Additional Metadata, and Contact Information fields. 

Additionally, the DPP Options tab includes options for adding 2 frames of white and 
tone, treating the last segment as a Textless Element (not part of the programme), 
ending a part with black, and specifying default, custom, or no slate, etc.

For information about how the many metadata fields and option selections are used, 
refer to the DPP user documentation. DPP is a separately licensed product.
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Create VOD from Catalogs (Create Binder) Mode
This configuration mode sets up Workflow Portal to enable VOD operators to browse 
catalogs to select VOD assets, set options, and add content branding, rating, metadata, 
and variables required for dynamic ad insertion for video on demand assets and submit 
them to a publishing workflow for generating CableLabs compliant VOD content and 
optional CableLabs-compliant VOD that is provisioned for Dynamic Ad Insertion (DAI):

 

To make use of these features, portal configurations created with prior Vantage 
versions prior to 7.0 must be recreated. VOD Workflow Portal project files should also 
be recreated if the Vantage 6.3 customer-only VOD DAI Local Ad Portal patch has not 
been applied, to make use of Local ad descriptors. 

Note: If configurations and project files are not recreated, existing portal 
configurations and project files will continue to operate as before, but the new 
features will not be available. 

The following tabs identify the workspaces provided in a VOD configuration. In each 
tab, you’ll configure the options as required for your specific application.

Browsable Catalogs—This is a required tab for VOD Portal applications. Configure this 
tab to specify one or more catalogs the operator can browse to select VOD assets for 
processing, and enable the necessary options for your application. For details, see 
Enabling and Disabling Access to Catalogs.

Labels—Configure this tab to specify which labels the operator can select and update. 
For Digital Ad Insertion (DAI), an industry-standard label (CableLabs DAI) is required. 
For details, see Using the Label Tab.

Forward to Workflows—Configure this tab, specifying one or more publishing 
workflows to which the operator can forward VOD assets for processing. Check each 
workflow to indicate whether it is a required or optional publishing workflow. If you 
have multiple, optional workflows you can display the Forward to Workflows panel in 
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VOD Portal, so the operator can select specific workflows for each job. For details, see 
Using the Forward to Workflows Tab.

Permitted Users—When the User Management feature is enabled, you can use the 
Vantage Management Console to define which Vantage users can access each Vantage 
Workflow Portal configuration. You can enable access for one, some, or all users. See 
Using the Permitted Users Tab for details.

Binder Details View— Configure this tab to specify the details about each binder to 
display to the operator. For details, see Using the Binder View Tab.

Storage—Configure this tab to set up storage options for the files created as the 
operator prepares jobs for processing. There is no visible indication of this store in the 
Portal. For details, see Using the Storage Tab.

Graphic Settings—Configure this tab to specify display options for branding and ratings 
systems bugs for this asset. For details, see Using the Graphic Settings Tab.

Timeline Navigation—Configure this tab to set timeline default values. The Silence 
settings determine the default definition of silence in db and minimum duration. These 
values are displayed in the VOD/DAI Portal Timeline tab, where their values can be 
changed from the default values set here.

Embedded Metadata Settings—Configure this tab to specify copy protection options 
and the ratings system and rating for this asset. For details, see Using the Embedded 
Metadata Settings Tab.

Variables—Configure this tab to set up variables that will be propagated from the 
ingest workflow or portal settings to the output workflow. For details, see Specifying 
Content Rating Variables.
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Tempo Re-time Asset from Catalogs (Create Binder) Mode
This configuration mode converts the Workflow Portal into a Tempo Portal that allows 
operators to browse catalogs to select and re-time media assets, increasing or 
decreasing their running time. Tempo configuration is covered here generally and in 
specific detail in the Tempo Guide available by searching the Telestream.net web site:

The following tabs identify the workspaces provided in a Re-time configuration. In each 
tab, you’ll configure the options as required for your specific application.

Browsable Catalogs—This is a required tab for Tempo Portal applications. Configure this 
tab to specify one or more catalogs the operator can browse to select assets for re-
timing, and enable the necessary options for your application. For details, see Enabling 
and Disabling Access to Catalogs.

Labels—Configure this tab to specify which metadata labels the operator can select 
and update. For details, see Using the Label Tab.

Forward to Workflows—Configure this tab, specifying one or more re-timing workflows 
to which the operator can forward media for processing. Check each workflow to 
indicate whether it is required or optional. If you have multiple, optional workflows you 
can enable the Show Forward to Workflows panel in the Tempo Portal, so the operator 
can select specific workflows for each job. For details, see Using the Forward to 
Workflows Tab.

Permitted Users—When the User Management feature is enabled, you can use the 
Vantage Management Console to define which Vantage users can access each Vantage 
Workflow Portal configuration. You can enable access for one, some, or all users. See 
Using the Permitted Users Tab for details.

Binder Details View— Configure this tab to specify the details about each binder to 
display to the operator. For details, see Using the Binder View Tab.

http://www.telestream.net
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Storage—Configure this tab to set up storage options for the XML (CML) composition 
files created by the portal as the output of the re-timing editing process. There is no 
visible indication of this store in the Portal. For details, see Using the Storage Tab.

Tempo Settings—Configure this tab to include and re-time or exclude embedded or 
file-based closed captions. A field is provided to browse for SCC closed caption files, 
and a timecode entry and +/- selection allow you to adjust caption start timing forward 
or backward to match associated media timing. The tab also includes default timecode 
and re-timing settings. A check box beside the settings can be checked to make them 
Read Only to prevent operator intervention. Alternatively, you can uncheck Read Only 
to allow operators to replace default values in the Tempo Portal at their discretion. For 
details, see Using the Tempo Settings Tab.

Graphic Settings—Configure this tab to specify display options for station branding and 
ratings systems bugs. For details, see Using the Graphic Settings Tab.

Timeline Navigation—Configure this tab to set timeline default values. The Silence 
settings determine the default definition of silence in db and minimum duration. The 
Artifact quality threshold sets a default value for defining artifacts noted on the 
preview player timeline. These values are displayed in the Tempo Portal Timeline tab, 
where their values can be changed from the default values set here.

Embedded Metadata Settings—Configure this tab to specify the ratings system and 
rating metadata. For details, see Using the Embedded Metadata Settings Tab.

Variables—Configure this tab to set up the use of default content rating system 
variables. For details, see Specifying Content Rating Variables.

Using the Tempo Settings Tab
The Tempo Portal includes a tab and panel for Tempo Settings where you can specify 
standard settings to use for increasing or decreasing media duration:

1. Select the Tempo Portal configuration in the configuration mode list.

2. Select the Tempo Settings tab.
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3. Select re-timing default settings in the Tempo Portal:

a.  Select Preserve and re-time captions to include captions in the re-timing 
process. 

b. To include a subtitle or caption (SCC or STL) file that plays with the re-timed 
media file, browse for and specify the file in the Subtitle/caption file field. 

c. The starting timecode in the caption/subtitle file must match the starting 
timecode of the media file.

d. To adjust the start time of caption/subtitle file timecode, select Subtitle/caption 
offset, enter the amount of offset in timecode, and set Subtitle/caption offset 
sign (+ or -) to adjust the offset forward or backward.

e. Use Set timecode at to determine where to start timecode for the re-timed 
output. You can preserve existing source timecode, start timecode at the first or 
last frame of the program, or the first or last frame of the output file. 

f. Select Re-Time to increase or decrease media duration by the Amount selected 
or to match an overall target duration for the entire program. An amount 
specified here becomes the default setting in the Tempo Portal Segment List tab.

g. Use Amount to set the amount of re-timing in frames per second. The display 
shows the hours, minutes, seconds, and frames setting. 

Note: Checking Read Only for each of the above options displays the default setting 
but disallows changing the setting in the Portal. The default setting is always used.

4. Select the Timeline Navigation tab to check and set Tempo timeline default values. 
The Silence settings determine the default definition of silence. The Artifact quality 
threshold sets a default value for defining artifacts noted on the preview player 
timeline. These values are displayed in the Tempo Portal Timeline tab, where their 
values can be changed from the default values set here. See the Tempo User Guide 
for details. 

5. Make selections and entries in all the other tabs according to what operators will 
need in their workflows and portal views. How to use each of these tabs is 
described in this chapter (see the topics listed under Using the Tabs).

Click the Save button  to save your portal configuration. Operators will now be able 
to select and use this configuration in their Workflow Portals.
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Syndication Mode
The Syndication configuration sets up the portal as a TrafficManager Syndication Portal. 
This portal allows operators to manage ingested syndicated content and show timing 
metadata. Operators can preview, trim, add, and delete segments and create templates 
for automated management of shows that follow a predictable format. The portal 
allows submitting the modified show media to publishing workflows with included 
show timing metadata, both of which can be published to broadcast or playout servers:

The following tabs identify the workspaces provided in a Re-time configuration. In each 
tab, you’ll configure the options as required for your specific application.

Syndication Settings—Configure this tab to select a Default template to apply to shows 
in the portal to display show segments. Template permissions allow portal operators to 
Create and modify templates, Create only, or None (cannot create or modify templates). 

The Syndication mode setting allows outputting a show in one of these ways: 

• Segmenting outputs the show in segments with XML and CML files for each seg-
ment.

• Stitching produces a complete show with one XML and one CML output.

• Pass-Thru outputs the original XML attachment and does not output a CML file. Use 
Pass-Thru mode if you want to retain the structure of the original media file.

Segment naming allows appending a number or a letter to the show name. Hyphens 
can be inserted into the name before the digits if Insert hyphen is checked (default), or 
if unchecked, no hyphen is included. See Using the Syndication Settings Tab for details.
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Browsable Catalogs—This is a required tab for Syndication Portal applications. 
Configure this tab to specify one or more catalogs the operator can browse to select 
assets for management, and enable the necessary options for your application. For 
details, see Enabling and Disabling Access to Catalogs.

Labels—Configure this tab to specify which metadata labels the operator can select 
and update. For details, see Using the Label Tab.

Variables—Configure this tab to set up variables that will be propagated from the 
ingest workflow or portal settings to the output workflow. For details, see Using the 
Variable Tab.

Forward to Workflows—Configure this tab, specifying one or more syndication 
workflows to which the operator can forward media for processing. Check each 
workflow to indicate whether it is required or optional during a submit. If you have 
multiple, optional workflows you can enable the Show Forward to Workflows panel in 
the portal, so the operator can select specific workflows for each job. For details, see 
Using the Forward to Workflows Tab.

Permitted Users—When the User Management feature is enabled, you can use the 
Vantage Management Console to define which Vantage users can access each Vantage 
Workflow Portal configuration. You can enable access for one, some, or all users. See 
Using the Permitted Users Tab for details.

Binder Details View— Configure this tab to specify the details about each binder to 
display to the operator. For details, see Using the Binder View Tab.

Storage—Configure this tab to set up storage options for the XML (or CML) 
composition files created by the portal as the output of portal operations. There is no 
visible indication of this store in the Portal. For details, see Using the Storage Tab.
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Using the Syndication Settings Tab
The Syndication Portal configuration includes a tab and panel for Syndication Settings 
where you can specify standard settings that control portal operation: 

1. Select the Syndication configuration in the configuration Mode list.

2. Select the Syndication Settings tab.

3. Select Default template to choose the template that will automatically be applied to 
shows in the portal. (If you select << No Template >>, the Syndication Portal creates 
a Segment List from the source XML file processed by the Syndication action.)

4. Set the Template permissions to define whether portal operators can Create and 
modify templates, Create only, or do nothing (None) with templates.

5. Set the Syndication mode to output segments (Segmenting), a complete show 
(Stitching) or a complete show with Syndication attachment consisting of the 
original XML sidecar file modified for timing only (Pass-Thru).

6. Set Segment naming to Append number, Append letter or Do nothing to file naming. 
A hyphen is included before the number or letter if Insert hyphen is checked 
(default), or omitted if unchecked.

7. Make selections and entries in all the other tabs according to what operators will 
need in their workflows and portal views. How to use each of these tabs is 
described earlier in this chapter (see the topics listed under Using the Tabs).

Click the Save button  to save your portal configuration. Operators will now be able 
to select and use this configuration in their Workflow Portals.
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Using the Tabs
Configuration tabs at the bottom of the Workflow Portal configuration window include 
specialized tabs for particular configurations (described in Selecting a Configuration 
Mode) as well as generic tabs that are essentially the same for all configurations. The 
following topics explain how to use the generic tabs.

 Using the Browsable Catalogs Tab

 Using the Binder View Tab

 Using the Label Tab

 Using the Variable Tab

 Using the Forward to Workflows Tab

 Using the Storage Tab

 Using the Graphic Settings Tab

 Using the Embedded Metadata Settings Tab

 Using the Permitted Users Tab

Using the Browsable Catalogs Tab
For catalog-based configurations, Vantage allows you to specify how operators access 
those catalogs and the binders they contain, as described in the following topics:

 Enabling and Disabling Access to Catalogs

 Hiding and Displaying the Catalog List

 Hiding and Displaying the Media List (Nicknames)

 Managing Asset Requirements for Ingest Workflows

 Enabling and Disabling Binder Deletions

Enabling and Disabling Access to Catalogs
All modes except Browse Windows Network support catalog access control on a per-
configuration basis. When you configure a Vantage Workflow Portal configuration, any 
users who have access to the configuration have access to any catalogs supported by 
that configuration and to the binders the catalogs contain.

The default setting for each catalog-based configuration enables access to all catalogs 
for all users who have access to the configuration. To limit access to one or more 
catalogs, you add the catalogs to the Visible to user list as described in the procedure 
below. When the list is empty, all catalogs are available to all permitted users. Once a 
catalog name is added to the Visible to user list, the permitted users can view and access 
only catalogs in the list; all other catalogs are hidden for that configuration.

Note: If you use only the supplied Default Catalog, you can add it to the Visible to user 
list to limit default availability of future catalogs to configuration users, or you can 
leave the Visible to user list empty to enable automatic access to future catalogs for all 
users. See Managing Catalogs in the Vantage Domain Management Guide.
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To enable or disable operator access to a catalog, do this:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To add a catalog to the list of available catalogs, select the catalog in the Available 
list and click Add.

4. To remove a catalog from the list of available catalogs, select the catalog in the 
Visible to user list and click Remove.

5. Click the Save button  to save your changes:

Hiding and Displaying the Catalog List
If your domain uses only one catalog, you can simplify the Vantage Workflow Portal 
operator interface by hiding the list of catalogs, which is also called the catalogs 
browser. If operators need access to multiple catalogs using a single Vantage Workflow 
Portal configuration, you should display the catalogs browser so that operators can 
select a catalog to work with.

The design and choice of catalogs has an impact on how easily operators can perform 
their tasks. For example:

• The Forward configuration can be set to automatically remove the binder from the 
catalog when it is forwarded. The catalog can serve as a task list for operators.

• In the Copy configuration, binders are not removed from the catalog by the opera-
tors. As a result, you might want to set appropriate expiration times on the catalogs.

• In all cases, you can use folders to structure how operators see assets. For example, 
bumper assets may be kept in a Bumpers folder, separate from Primary Assets, in a 
Primary Assets folder.
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• You might have multiple ingest workflows all providing binders to a target catalog.

To hide or display the catalogs browser, do this:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To hide the catalogs browser, clear the Show Catalogs browser check box.

4. To display the catalogs browser, check the Show Catalogs browser check box.

5. Click the Save button  to save your changes.

Hiding and Displaying the Media List (Nicknames)
The media list displays the media files for a binder/job that you select in the binder list. 
For example, the media list might include the original media submitted to a workflow 
and the output media from that workflow. When the media list is visible, operators can 
play the media or view the contents of the folder that contains the media.

To hide or display the media list, do this:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To hide the media list, clear the Show media nickname list check box.

4. To display the media list, check the Show media nickname list check box.

5. Click the Save button  to save your changes.

Managing Asset Requirements for Ingest Workflows
When you create a catalog-based configuration, Vantage allows you to define whether 
or not media files, labels, and attachments referenced in the target workflow are 
required in the ingest workflow. If you require these assets, Vantage does not process 
ingest workflows that are missing these items. If you do not require these assets, 
Vantage does not check the ingest workflow for the assets and attempts to process the 
ingest workflow regardless of any specific assets.

Note: A target workflow can fail if required assets are not provided by the ingest 
workflow.

To configure asset requirements for ingest workflows, do this:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To require assets in the ingest workflow, check the Require all expected nicknames 
check box.

4. To make reference assets optional, clear the Require all expected nicknames check 
box.

5. Click the Save button  to save your changes.
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Enabling and Disabling Binder Deletions
When configuring a Vantage Workflow Portal catalog-based configuration, you can 
enable or disable the manual binder deletion by operators. Some modes also give you 
the option to enable or disable automatic binder deletion. The following topics provide 
more information on binder deletion:

 Configuring Binder Deletions

 Configuring Automatic Binder Deletions

Note: Vantage provides several levels of control over binder deletion. For more 
information, see Understanding Binders in the Vantage Domain Management Guide.

Configuring Binder Deletions
In some modes, you can enable or disable manual deletion of binders by checking the 
Allow Binder Delete check box. When enabled, this feature allows operators to remove 
binders from the catalog after the associated jobs are submitted, leaving only binders 
that have not yet been processed. This effectively makes the catalog a manually-
managed task list that operators can control at their discretion. 

If you prefer to save binders and do not want operators to delete them, uncheck the 
Allow Binder Delete check box. 

Note: Binder deletion is also controlled by expiration times defined in the workflow 
Register action or catalog configuration.

To enable or disable operator binder deletions, do this:

1. Select the Workflow Portal Configuration to change.

2. Select the Browsable Catalogs tab.

3. To enable binder deletions, check the Allow Binder Delete check box.

4. To disable binder deletions, clear the Allow Binder Delete check box.

5. Click the Save button  to save your changes.

Configuring Automatic Binder Deletions
Several modes allow you to enable or disable the automatic deletion of binders. When 
automatic binder deletion is enabled, the binder from the source workflow is removed 
from the catalog when the operator submits a job to a target workflow. This effectively 
makes the binders in a catalog an automatically managed task list that removes each 
binder after the operator takes action on it.

Note: Binder removal from the catalog is also controlled by expiration times defined 
in the workflow Register action. Removing the binder from the catalog after job 
submission does not actually delete the binder, since the binder is being used in the 
job that was just submitted.

To enable or disable automatic binder deletions, do this:
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1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To enable automatic binder deletions, check the Auto Delete Binder check box.

4. To disable automatic binder deletions, clear the Auto Delete Binder check box.

5. Click the Save button  to save your changes.

Enabling and Disabling Binder Filtering
You can use the binder filtering feature to enable or disable operator control of the 
binder contents that are submitted to a workflow with the Vantage Workflow Portal. 
When binder filtering is enabled, the portal Submit Jobs dialog displays the Media Files 
and Attachment tabs:

The Media Files and Attachments tabs list all media and attachments associated with 
the job. Vantage Workflow Portal operators can use the controls on these tabs to filter 
(not submit) select assets and change nicknames. If you disable this feature, neither tab 
is visible to the operator, and each submission includes all binder assets.

To enable or disable binder filtering, do this:

1. Select the configuration to change.

2. Select the Browsable Catalogs tab.

3. To enable binder filtering, check the Allow Binder Filtering check box.

4. To disable binder filtering, clear the Allow Binder Filtering check box.

5. Click the Save button  to save your changes.

Using the Binder View Tab
Vantage allows you to control what Operators see in the Vantage Workflow Portal 
binder list. The standard features that you can display for each binder are:

• Binder name
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• Binder creation date

• Binder expiration date

• Play button

• Submit button (not available in all modes)

You can also display parameters for any of the metadata label parameters that are 
defined in the domain.

Note: Vantage allows you to hide all columns and controls in the binder list, which 
means that no items appear in the binder list. At least one display or control item 
should be configured to display so that binders appear in the binder list.

The following topics describe how to configure what displays in the binder list:

 Defining the Standard Feature Settings

 Adding and Deleting Columns for Metadata Parameters

Defining the Standard Feature Settings
To enable or disable the standard binder display components, do this:

1. Select the configuration to change.

2. Select the Binder Details View tab.
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3. Check each feature check box to display the information or control, or clear the 
check box to hide the feature. The following are standard features:

– Binder name. Displays the name assigned to the binder when it was created.

– Created. Displays the date and time the binder was created.

– Expiration. Displays the date and time the binder expires.

– Play button. Displays a button that the operator can use to play or pause the 
selected job.

– Submit button. Displays a button that the operator can use to submit a job to 
another workflow.

Note: The play button operates only when the workflow has generated and 
registered a proxy file (see the Using Workflow Portal topic in the Vantage User Guide). 
The Submit button displays only when target workflows are selected on the Forward 
to Workflows tab.

4. Click the Save button  to save your changes.

Adding and Deleting Columns for Metadata Parameters
To add or delete metadata parameter columns for the binder list, do this:

1. Select the configuration to change.

2. Select the Binder Details View tab.

3. Click the Column button .

4. Do this for each metadata label parameter for which you want to display a column:

a. Select a metadata label in the Labels panel.
b. In the Parameters panel, check the check box for the metadata label parameter 

you want to display.
c. When you are done making changes, click OK.

5. For each metadata label parameter column that you want to remove from the 
binder view, do this:

a. Select the parameter in the parameter list.
b. Click the Delete button  to delete a parameter from the parameter list, and 

then confirm the delete.

6. To change the displayed order of parameters, select a parameter in the parameter 
list (Ctrl-click or Shift-click to select multiple parameters) and use the green up  
and down arrow  buttons to move the variable in the list.

7. Click the Save button  to save your changes.
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Using the Label Tab
Vantage allows operators to view and set metadata labels when they submit jobs to a 
workflow. These labels can be used by the workflow to customize job processing.

Note: For an introduction to metadata labels, see Understanding Metadata Labels in 
the Vantage Domain Management Guide.

When an operator views metadata labels in Vantage Workflow Portal, the labels that 
appear in the binder are only those labels that are set in the workflow and configured 
to be visible for the portal configuration. If the portal configuration supports it, 
operators can add and delete labels in the binder for the target workflow. 

Trim groups can be configured in metadata labels. A trim group consists of three 
timecode controls for trimming media proxies: In point, Out point, and Duration. 
Creating multiple trim groups allows operators to trim multiple times along the video 
timeline, for example, to remove multiple black separators between video segments. 

Vantage also allows you to configure hotkeys for setting the time code values. When an 
operator locates a frame and wants to set a label parameter to the time code for the 
specified frame, the operator simply presses the appropriate hotkey for Mark In, Mark 
Out, or Duration, and the timecode is recorded in the label parameter. 

The Options button opens a dialog for selecting a label parameter display mode. Label 
parameters can be set to be visible (normal), hidden, or read-only to portal operators. 

To configure metadata label usage for operators, do this:

1. Select the configuration to change.

2. Select the Labels tab.

Note: Before a metadata label can be made available to an operator, it must be 
defined using the Vantage Management Console as described in Creating Metadata 
Labels in the Vantage Domain Management Guide.
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3. To enable or disable operator viewing of all metadata labels in the portal, check 
(enable) or clear (disable) the Show Metadata Labels check box.

4. To allow or disallow operators to add and delete metadata labels to binders, check 
(allow) or clear (disallow) the Allow Add/Delete check box.

Note: The Allow Add/Delete check box is not provided in Browse Windows Network 
mode because you are viewing files, not binders. You must run a job in a workflow to 
create a binder before you can add labels to the binder.

5. To make an individual metadata label accessible in the portal, do this:

a. Select a label in the Available panel. (Ctrl-click or Shift-click to select multiples.)
b. Click Add.

6. To remove previously accessible metadata labels from the portal, do this:

a. Select labels in the Visible to user list. (Ctrl-click or Shift-click to select multiple 
labels).

b. Click Remove. This moves the labels back to the Available list (not accessible in 
the portal).

7. To change label order, select labels in the Visible to user list (Ctrl-click or Shift-click to 
select multiples) and use the green up  and down arrows  to move the labels.

8. Add Trim Groups (if desired) to labels that include time code. Trim groups allow 
operator trimming of media by setting timecode in and out points and clip 
duration at multiple locations in the media timeline (as many locations as the 
number of trim groups):

a. Select the label in the Visible to user list.
b. Click Trim. This opens a Trim Groups dialog. 
c. Select Add New Trim Group in the Trim Groups dialog. 
d. Use the add Mark In, Mark Out, and Mark Duration menus to add those trim 

controls to the Workflow Portal display for that label. 
e. Click OK to save your changes (or Cancel).
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9. You can define hotkeys for each of the timecode controls:

a. Select the metadata label in the Visible to user list.
b. Click the menus and select hotkeys corresponding to the Mark In, Mark Out, and 

Duration controls.
c. If you want to clear all hotkeys, you can click the Clear button and then click OK 

to confirm the clear.
d. Click OK to save your changes (or Cancel). 

10. To change how individual label parameters are displayed:

a. Click a label in the Visible to user column. 
b. Click Options... The Label Parameter Display Options dialog opens.
c. Select the label parameters one at a time and set the drop-down menu to normal 

to make the label visible and editable, hidden to make the label invisible, or read-
only to make the label visible but uneditable. 

d. Click OK to confirm your choices and close the dialog. 

11. Click the Save button  to save your portal configuration changes.

Note: When testing your Vantage Workflow Portal configuration, the metadata label 
display is different for the different configuration modes. For the Browse Windows 
Network mode, labels are only visible to operators after they select a media file and 
target workflow and click Submit. For Browse Catalogs (copy binder) mode, labels are 
only visible to operators after they select a binder and target workflow and click 
Submit. For Browse Catalogs (forward binder) mode and Create EDL from Catalogs 
mode, labels are visible to operators as soon as they select a binder.
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Note: The duration timecode can be dropframe or non-dropframe, depending on the 
setting of the Use dropframe notation for duration when appropriate check box in the 
Vantage Management Console Workflow Portal Configurations panel. By default 
(unchecked), durations are always shown in non-dropframe. When checked, durations 
match the dropframe setting of the in/out values.

Using the Variable Tab
Vantage allows operators to save values and settings in the portal as variable values. 
These values may then be passed to the workflows specified in the Forward to 
Workflows tab to affect downstream processing.

Note: For an introduction to Vantage variables, see Understanding Variables in the 
Vantage Domain Management Guide. Also note that the Variables tab differs for VOD 
and Tempo modes—see Specifying Content Rating Variables below.

To enable or disable operator use of variables, do this:

1. Select the configuration to change.

2. Select the Variables tab.

Note: Before a variable can be made available to an operator, it must be defined 
using the Vantage Management Console as described in Creating Variables in the 
Vantage Domain Management Guide.

3. To make a variable available to operators, do this:

a. Select one or more variable names in the in the Available panel. (Ctrl-click or 
Shift-click to select multiple names.)

b. Click Add.
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4. To hide variables from operators, do this:

a. Select one or more variables in the Visible to user panel. (Ctrl-click or Shift-click to 
select multiple variables.)

b. Click Remove.

Note: When all variables are hidden from operators, the Variables tab does not show.

5. To change the displayed order of variables, select a variable in the Visible to user 
panel and use the green up  and down arrow  buttons to move the variable in 
the list. (You can Ctrl-click or Shift-click to select multiple variables and move them.)

6. Click the Save button  to save your changes.

Note: If you are testing your Vantage Workflow Portal configuration, variables are 
only visible to operators after they select a binder and target workflow and click 
Submit.

Specifying Content Rating Variables
VOD and Tempo mode configurations offer a different set of variables. These modes 
allow you to specify the variables you need for your particular application. 

To specify variables, do this:

1. Select the configuration to change and display the Variables tab.

2. Check each item of information (Rating System, or CGMS-A, for example) that you 
want to supply to the workflow, and then select the variable to use. Typically, you’ll 
choose the variable of the same name.

3. Click the Save button  to save your changes.
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Using the Forward to Workflows Tab
With the appropriate permissions, Vantage operators can forward binders to one or 
more target workflows for further processing. As a Vantage administrator, you can 
control the following:

• Whether operators can view the Forward to Workflows tab in the portal.

• The target workflows to which operators can forward binders.

• Whether operators are required to forward to a target workflow.

When workflow forwarding is enabled in a Vantage Workflow Portal configuration, 
operators can forward to any visible target workflow by selecting the workflow on the 
Forward to Workflows tab and clicking Submit. If a target workflow is required, it is 
automatically selected on the Forward to Workflows tab and the binder is forwarded to 
the required workflow when the operator clicks Submit.

To enable or disable binder forwarding to other workflows:

1. Select the configuration to change.

2. Select the Forward to Workflows tab. 

3. To enable or disable operator viewing of target workflows, check (enable) or clear 
(disable) the Show Forward to Workflows check box.

Note: If you disable operator viewing of target workflows, you also disable operator 
forwarding to target workflows, if “Req’d” is not checked. When “Req’d” is checked, 
operators can submit to the required workflows even though they can’t see them.

4. To make target workflows available to operators, do this:

a. Select workflow names in the Available panel. (Ctrl-click or Shift-click to select 
multiple workflow names.)

b. Click Add.
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Note: To accept forwarded binders, the target workflow must contain at least one 
Receive action. The Available panel only displays workflows that contain a Receive 
action.

5. To specify whether a target workflow is required for forwarding or optional, check 
(required) or clear (optional) the Req’d check box next to the workflow in the 
Visible to user panel.

6. To hide workflows from operators, do this:

a. Select one or more users in the in the Visible to user panel. (Ctrl-click or Shift-click 
to select multiple workflows.)

b. Click Remove.

7. Click the Save button  to save your changes.
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Using the Storage Tab
EDL, CML, and XML files specified in the EDL, CML, DPP, VOD, and Tempo mode 
configurations can be stored in any Vantage store or folder, or they can be stored in a 
special Vantage store or folder, designated for these files. 

Note: The Microsoft User Account Control (UAC) feature may deny access to Vantage 
stores or folders that are placed in protected locations. If Vantage users report that 
access to a Vantage store or folder is denied, do one of the following: 
1. Place the store or folder in a directory that is not protected by UAC. 
2. Use the procedure below to specify a different store or folder. 

To specify a storage location, do this:

1. Select the configuration to change.

2. Select the Storage tab.

3. To store files in any available Vantage store, select Available Vantage Store.

4. To store the files in a specific Vantage store or folder, select Vantage Store/Folder 
radio, and select a Vantage store or folder in the drop down list.

5. Click the Save button  to save your changes.

This completes storage configuration. There is no visible indication of storage locations 
in the Portal, but the assigned storage location will be used when needed.
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Using the Graphic Settings Tab
VOD and Tempo mode configurations allow you to specify up to five layers of content 
branding and also to specify rating system graphics display options for jobs you’re 
preparing for publication.

Select the configuration to change and select the Graphic Settings tab.
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Setting Up Content Branding Layers
To specify content branding options, do this:

Under Content Branding, check each layer you’ll need in your output, and for each 
layer, set the following controls. (For every layer you check, it is displayed in the VOD 
Portal.)

– Layer Name: Specify a logical name for this layer (displays in the VOD Portal to 
identify the layer for the operator; does not affect output).

– Overlay: Browse to select (or manually enter) the fully-qualified path to the 
graphic you want to use as the branding bug. Also check Read Only if you don’t 
want the operator to use another file. See the list of supported formats, below.

– Specify the XY position of the top, left corner of the graphic on the frame, and the 
width and height of the viewing rectangle.

– Specify the opacity of the graphic.

– Check Entire Segment to display the bug continuously, or uncheck and specify 
the time for the display. For either setting, specify the frequency of display and 
the fade duration in and out.

Setting Up Rating System Options
To specify Ratings System options, do this:

1. Under Rating, set the following controls.

– Placement and Duration: Select Use Defaults (See the Advisory element topic in 
the Post Producer Developer’s Guide for default settings) or select Custom and 
set the following controls.

– First and Subsequent Segments: Specify the XY position of the top, left corner of 
the graphic on the frame, and the width and height of the viewing rectangle.

2. Click the Save button  to save your changes.

BMP EMF EXIF GUID

ICON JPEG Memory BMP‘ PNG

TIFF TGA WMF Single-layer 
Photoshop (PSD)
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Using the Embedded Metadata Settings Tab
VOD and Tempo mode configurations allow you to specify default copy protection 
options (VOD only), OTT Black Duration (VOD only) and ratings system settings (both 
VOD and Tempo) for jobs you’re preparing for publication. 

In the VOD portal, the OTT Ad insertion type causes the number of selected frames to 
be replaced with black. In the portal configuration, the OTT Black Duration setting 
determines the default length of the black replacement. The VOD Portal operator can 
override this default by setting a different value for OTT Black Duration in the portal 
Embedded Metadata tab. 

To set the default OTT Black Duration, enter a timecode value, and set the drop-down 
menu to the frame rate. Using Time allows you to set the value in seconds instead of a 
frame rate and makes the setting frame rate independent. Checking the Read Only 
option prevents portal operators from changing this default value. 

To specify default copy protection and ratings system settings, follow these steps:

1. For copy protection (VOD only), select one option from the CGMS-A menu:

– Not Set

– Copy Freely (0,0)

– Copy No More (0,1)

– Copy Once (1,0)

– Copy Never (1,1)

2. Read Only: Check to show the settings to the operator without allowing changes.

3. For Ratings Systems, select the ratings system from the Ratings menu.

4. Read Only: Check to show the settings to the operator without allowing changes.

5. Specify the rating to apply, and the justification for this content.

6. Click the Save button  to save your changes.
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Using the Permitted Users Tab
When the User Management feature is enabled, you can use the Vantage Management 
Console to define which Vantage users can access each Vantage Workflow Portal 
configuration. You can enable access for one, some, or all users.

Note: For more information on the user management feature, see Managing Vantage 
Users in the Vantage Domain Management Guide.

To define which users can access a Workflow Portal configuration, do this:

1. Select the configuration to change.

2. Select the Permitted Users tab.

3. To grant access to all users, check the Everyone check box.

4. To grant access to one or more Vantage users, do this:

a. If the Everyone check box is checked, clear the check box.
b. Select one or more users in the in the Available panel.

To select multiple names, you can press Control and click multiple non-contigu-
ous names, or you can click one name, then press Shift and click another name to 
select a contiguous series.

c. Click Add.

5. To remove access for one or more Vantage users, do this:

a. Select one or more users in the in the Permitted users panel.

You can use the Control and Shift keys to select multiple users as described in the 
previous step.

b. Click Remove.

6. Click the Save button  to save your changes.
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Using Workflow Portal 
Configurations

This chapter describes how to operate each of the basic Workflow Portal 
configurations. Workflow Portal configurations are created in the Vantage 
Management Console. The functionality options and user interface components are 
specific to each type of configuration and are enabled in Workflow Portal when it is 
launched.

A Vantage administrator can make as many of each type of configuration as necessary, 
each one configured to support a specific media processing application. 
Configurations are developed in conjunction with a workflow designer, so that the 
configuration performs correctly with the associated ingest and publication workflows. 
Once you’ve used a configuration, the Workflow Portal opens to it automatically. 

Note: When you are using a given type of configuration—for example, a VOD 
configuration—it is common to think of and refer to Workflow Portal simply as the 
VOD Portal. When you read about a portal by any name (VOD, DPP, etc.), just 
remember—this particular Portal is Workflow Portal using its respective configuration.

Topics
■ Using Browse Catalogs Copy Binder and Forward Binder Portals

■ Using a Windows Network Portal

■ Using EDL Portals

■ Using CML Portals

■ DPP Portal Overview

■ VOD | DAI Portal Overview

■ Tempo Portal Overview

■ Syndication Portal Overview

Note: Some of these configurations are described in their own product guides. Please 
refer to those guides for additional details.
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Using Browse Catalogs Copy Binder and Forward 
Binder Portals

Note: These configuration can be used in both the Workflow Portal Windows client 
and the Workflow Portal web app.

The Browse Catalogs configurations are the most broadly-focused operator-
intervention configurations. In these configurations, the key requirement is the 
registration of media in a catalog using an ingest workflow. This enables an operator to 
select it and review a proxy, edit metadata and variable values as required, and submit 
it to one or more publishing workflows. 

Browse Catalog configurations are not designed to solve any specific media processing 
application (such as DPP or CML); they simply enable operator-intervention processing 
of media registered in a Vantage catalog.

Note: Media trimming can be implemented in Workflow Portal in both Browse 
Catalog configurations. For example workflows, go to the Vantage Support page on 
the Telestream web site, and download the Workflow Examples zip file for your version 
of Vantage.

In a Browse Catalog Copy Binder Portal, the operator browses a catalog and selects a 
binder to prepare before submitting the job to a publishing workflow. A Copy Binder 
configuration automatically duplicates the original binder and submits the duplicated 
binder (with changes made by the operator) to the publishing workflow, leaving the 
original binder intact in the catalog for future use or re-submittal. (If you may ever need 
to use the copied binder later—in case of an error, for example—you should also use a 
Register action in the publication workflow to register the new binder in a catalog).

In order to have a binder to submit, the operator clicks the Submit button to trigger the 
duplication of the original binder. Now, using the copied binder as a template, the 
operator can edit metadata and variables as required, (in the copied binder) and submit 
it to the publishing workflow.

In contrast, in a Browse Catalog Forward Binder Portal, the original binder is modified by 
the operator during metadata and variable editing, and submitted to the publication 
workflow—without making a copy. (If you don’t need the binder after processing, you 
can automatically or manually delete it.) The operator can edit metadata and variables 
(in the original binder) directly in the main window and then click Submit to submit it 
to the publishing workflow.

Here are the differences between Copy Binder and Forward Binder configurations:

• Copy Binder—the operator clicks the Submit button before editing metadata and 
variables—to create a copy of the original binder.

• Forward Binder—the operator selects a binder and edits its metadata and vari-
ables—then click Submit to process the job.
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Depending on how the configuration has been set up, there will be variations in the 
features that are enabled, and the related tasks you can perform. In both 
configurations, the operator can review, edit, and update label-based metadata and 
variables for the selected media prior to submission to a publishing workflow.

Copy Binder Job Submittal Process
As depicted in the figure below, media is submitted to an ingest workflow through a 
watch folder, which performs any processing required, and registers the output media 
(organized with any other job-specific assets—metadata labels, for example—in a 
binder) into a specific Vantage catalog.

Alternatively, media can be submitted via a workflow, manually, or any other means. 

In Workflow Portal, the operator browses catalogs and selects a binder, clicks Submit to 
generate the copied binder, and performs operator tasks as appropriate. This may 
include scrubbing a proxy, reviewing and editing metadata, and setting variable values 
for the job.

Next, the operator submits the job to a publishing workflow, which can be designed to 
perform any task required. The binder being processed is a copy of the original binder. 
The original binder and its contents remain untouched.

Job Submittal Steps
When you’re using a Copy Binder Portal to process media, an operator follows this 
general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows associated with this process 
are running (in Workflow Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.
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3. Preview media in the Media Player (Previewing Proxy Media in the Media Player).

4. Check the workflow(s) you want to process the media with. This varies based on 
how the configuration is set up.

5. Click the Submit button to display the Submit Jobs window and prepare the copied 
binder’s assets for processing.

6. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

7. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

8. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).

Forward Binder Job Submittal Process
As depicted in the figure below, media is submitted to an ingest workflow through a 
watch folder, which performs any processing required, and registers the output media 
(organized with any other job-specific assets—metadata labels, for example—in a 
binder) into a specific Vantage catalog.

Alternatively, media can be submitted via a workflow, manually, or any other means. 

In Workflow Portal, the operator browses catalogs and selects a binder, clicks Submit, 
and performs tasks as appropriate. This includes reviewing and editing metadata, and 
setting variable values for the job as appropriate.

Next, the operator submits the job to a publishing workflow, which can be designed to 
perform any task required. The binder being processed is the original binder.
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Job Submittal Steps
When you’re using a Forward Binder Portal to process media, an operator follows this 
general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows associated with this process 
are running (in Workflow Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.

3. Preview media in the Media Player (Previewing Proxy Media in the Media Player).

4. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

5. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

6. Check the workflow(s) you want to process the media with. This varies based on 
how the configuration is set up.

7. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).
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Using a Windows Network Portal
Note: This configuration can only be used in the Workflow Portal Windows client.

The Browse Windows Network Portal (Windows Network Portal for short) allows you to 
select one or more media files from Windows servers and submit them to target 
workflows, depending on how the configuration is set up.

Like Browse Catalog configurations, Browse Windows configurations are also broadly-
focused. If the configuration permits, you can also add metadata to labels and edit 
variables to submit with the media. Unlike Browse Catalog configurations, assets 
normally associated with binders—pre-processed metadata labels, proxy files, etc.—
aren’t present.

In Workflow Portal, the operator browses a Windows file system and selects media, and 
performs tasks as appropriate. This includes reviewing and editing metadata, and 
setting variable values for the job as appropriate.

Next, the operator submits the job to a publishing workflow, which can be designed to 
perform any task required. 
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Job Submittal Steps
Windows Portal displays a Browse button—instead of a Vantage Catalog list:

1. Click the Browse button to display the Select media file(s) to submit dialog:

2. Use the Select media file(s) to submit dialog to select the file(s) to process.

3. Click Open.

Each file that you open displays in the Select media file(s) list.

Repeat the Browse process as necessary, to select and add more files from any 
directories.

If the file list is not correct, you can edit the list manually. For example, you can 
select a given file path and delete it. Or, you can edit a path or filename, copy and 
paste file paths, or add new ones. To delete the list entirely, click Clear.
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4. If multiple publish workflows are displayed in the Target Workflows list, check any 
target workflow to which you want to submit the media in the list.

If a checked box is not editable, this is a required workflow for this configuration.

5. Click Submit.

If the configuration does not provide any additional options, Windows Portal sub-
mits the selected media files to each of the selected publication workflows.

6. If the configuration supports metadata labels or variables, Windows Portal displays 
the Submit Jobs dialog with tabs for these options. Some configurations display a 
tab for metadata and variable editing.

7. When you are done preparing for submission, click Submit.
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Using EDL Portals
Note: This configuration can only be used in a Workflow Portal Windows client.

The EDL Portal enables you to create an Edit Decision List (EDL) which you submit to a 
publishing workflow to process the EDL. You select the media to use by browsing 
catalogs and selecting binders created from previously-completed ingest workflow 
jobs. You add clips to the clip list, update metadata and variables, and then stitch the 
clips together, encoding them in the publishing workflow to which you submit the EDL. 

The Telestream Edit Decision List (TSEDL) files created in EDL Portal can only be 
processed by Flip action-based workflows.

■ Ingest Workflow for EDL Processing

■ Job Processing and Submittal Steps
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Ingest Workflow for EDL Processing
To prepare media for stitching from an EDL, create an ingest workflow to encode it as 
required in a transcoding action, and register it in a catalog, following these guidelines:

• All media must have the same frame rate, timecode notation, and frame size, and 
the same media essence.

• Use a Flip or other transcoding action (if necessary), to encode your production 
media using one of these encoders: 

– MPEG-2 Program Stream

– VOD/MPEG-2 Transport Stream

– MXF

The output media must use the nickname Vantage EDL, so that the EDL configura-
tion can identify which media file to use for stitching.

• Use a Flip or other transcoding action to encode your proxy media for previewing/
clipping.

– QuickTime encoder, H.264 video codec, AAC audio codec, QuickTime 7.6.9 
installed

OR

– MP4 encoder, x264 video codec, AAC audio codec, QuickTime 7.7.6 installed

– See Previewing Proxy Media in the Media Player for additional proxy format details.

 Assign the nickname Vantage Proxy, so that the media player can play it.

Note: Be sure to encode proxies at the same rate and timecode notation as your 
production media. Clips that you mark use the proxy timecode—Workflow Portal 
applies it to the Vantage EDL media.

• Use a Keyframe action to produce keyframes—configured with the Keyframe 
encoder. Assign the nickname Vantage Thumbnail.

• Register the job in your target catalog to make it available to Workflow Portal.

Note: EDL Portal configurations expect binders to have media identified as Vantage 
EDL, Vantage Proxy, and Vantage Thumbnail. If you don’t follow these guidelines, the 
binders may not display in the catalog, you won’t be able to view the proxy to create 
clips or view keyframes, and your publication workflow may fail.
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Job Processing and Submittal Steps
After you have processed all of the media you want to stitch through your ingest 
workflow, open Workflow Portal with an EDL configuration to create your EDL and 
submit it for processing. When submitted, the files are clipped to the EDL settings and 
merged together into a single output file by the publishing Vantage workflow.

Follow this general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows are running (in Workflow 
Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.

3. For each binder you select, preview its media (Previewing Proxy Media in the Media 
Player) and use the Create EDL tab to add clips, setting mark-in/mark-out points to 
crop the media and update the metadata for each clip (Creating Clip Lists/
Segments).

4. Optionally, use the Metadata Labels tab to preview metadata. You can’t edit it in 
this panel.

5. In the Forward to Workflows (if displayed), check the workflow(s) you want to 
process the media with. This varies based on how the configuration is set up.

6. Click the Submit button to display the Submit Jobs window where you prepare the 
media’s assets for processing.

7. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

8. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

9. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).
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Using CML Portals
Note: This configuration can only be used in the Workflow Portal Windows client.

The CML (Composition Markup Language) Portal configuration is designed to create a 
Composition (CML) file that defines an EDL—the set of clips you’ve added from media 
registered in binders, which you submit to a Post Producer publishing workflow with a 
Conform action. The Conform action processes the composition, stitching the clips and 
renders a single media file as output, based on the specifications in the CML.

Note: Use of the Conform action requires a Post Producer license. For details on using 
Post Producer and compositions, see the Post Producer Developer’s Guide.

The Workflow Portal Create EDL configuration also supports EDL processing—using 
the Flip action—with similar functionality. However, the primary difference—and 
advantage—of using a CML Portal configuration is that you can incorporate clips from 
different media files with mixed essences. While the EDL Portal requires that all clips 
have the same frame rate, frame size and video codec; the CML Portal does not have 
this restriction. CML processing also improves VANC and caption processing.

The CML configuration is a create binder configuration—a new binder is automatically 
created and submitted to the publishing workflow.

The composition (CML file) created by the CML Portal can only be processed by 
Conform action-based workflows.

■ Prototype CML Configuration Workflows

■ Media Pre-processing, CML Creation, and Job Submittal
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Prototype CML Configuration Workflows
This topic describes prototype ingest and publishing workflows that you can use to set 
up a basic CML-based media processing system that involves operator-driven job 
submission using Workflow Portal. 

Before you can use Workflow Portal to operate a CML-based media processing system, 
you must create the following two workflows:

■ Prototype CML Portal Ingest Workflow

■ Prototype CML Portal Publishing Workflow

Prototype CML Portal Ingest Workflow
Use this topic to create an ingest workflow to create a proxy, optionally encode the 
media as required, and register it in a catalog, following these guidelines:

• Assign the output media the nickname Original so that the CML Portal can identify 
which media file to use as the source media when it generates the CML file for pro-
cessing in the publishing workflow.

• If required, use a transcode action (the Flip action, typically—not shown in the 
workflow above) to encode your media into one of the supported Post Producer 
formats (which accepts a much broader set of video, audio, and container formats 
than the Flip action does for EDL processing). See Post Producer Developer Guide For-
mats in the Post Producer Developer’s Guide or the Products > Post Producer > 
Specs page on the Telestream web site.

If you are re-encoding your media, since you can’t use the same nickname on input 
and output media in the same action, simply assign the input file a nickname other 
than Original.

• Use a Flip action to encode your proxy media for previewing/clipping.

– QuickTime encoder, H.264 video codec, AAC audio codec, QuickTime 7.6.9 
installed

OR

– MP4 encoder, x264 video codec, AAC audio codec, QuickTime 7.7.6 installed

•  Assign the nickname Vantage Proxy, so that the media player can play it.

Note: Make sure that you encode the proxy at the same rate and with the same 
timecode notation as your production media.

http://www.telestream.net/post-producer/tech-specs.htm
http://www.telestream.net/post-producer/tech-specs.htm
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• Use a Flip action to create a single thumbnail for viewing in the browser.

– Encoder: Keyframe Encoder

– Video Codec: JPEG

– Container: JPEG File

 Assign the nickname Vantage Thumbnail, to display them in Workflow Portal.

• Use a Register action to register the media in your target catalog to make it avail-
able in Workflow Portal.

Note: If you don’t follow these guidelines, the binders may not display in the catalog, 
you may not be able to set mark-in/mark-out points, and your stitch workflow may fail.

Prototype CML Portal Publishing Workflow
Use this topic to create a publishing workflow to stitch and encode your output file.

Unlike the ingest workflow, the requirements for your publishing workflow are minimal. 
In almost every case, in practice, your publishing workflow will be far more complex 
than the prototype shown here.

• The publishing workflow must start with a Receive action, so that it can accept an 
input file from Workflow Portal. The nickname of the input file is CML.

• Use a Conform action to stitch and encode your media using the specifications in 
the auto-generated CML file you submitted. Configuration details are described in 
the man pages in the Conform action.

These are the two required actions; all other actions and configurations depend on 
your publishing workflow requirements.
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Media Pre-processing, CML Creation, and Job Submittal
To prepare media for stitching, copy the media (one or more files) that you want to 
comprise your final output into the ingest workflow’s watch folder. 

The ingest workflow will submit a job for each file, and (depending on the workflow 
configuration), create a proxy, a thumbnail, optionally re-encode the media to meet 
Conform-action format requirements, and register the media in a binder in the target 
catalog.

After you have processed all of the media you want to stitch through your ingest 
workflow, open Workflow Portal with a CML configuration to create your CML and 
submit it for processing. When submitted, the files are clipped to the CML settings and 
merged together into a single output file by the publishing Vantage workflow.

When you’re using a Create CML Portal to process media, an operator follows this 
general process to submit a job (for details about a task, click on the link):

1.  Make sure that the publishing workflow or workflows associated with this process 
are running (in Workflow Designer).

2. Browse catalogs to select a binder (Browsing Catalogs for Media) for processing.

3. For each binder you select, preview the media and add clips, setting mark-in/mark-
out points to crop the media (Previewing Proxy Media in the Media Player) and 
update the metadata for each clip (Creating Clip Lists/Segments).

4. Check the workflow(s) you want to process the media with (Specifying Forwarding 
Workflows). This varies based on how the configuration is set up.

5. Click the Submit button (Submitting Jobs in the Windows Client) to display the 
Submit Jobs window where you prepare the copied binder’s assets for processing.

6. In the Metadata Labels tab (if displayed), review/edit metadata (Editing Metadata 
Labels).

7. In the Variables tab (if displayed), enter values for each variable (Specifying Variable 
Values).

8. Click the Submit button to submit a job for processing the media and its assets in 
the target workflow(s).

9. Click Submit. If variables are included in this configuration, Workflow Portal displays 
the Variables window, where you can supply run-time values.
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DPP Portal Overview
Note: The DPP Packager User Guide is also provided for complete details regarding the 
production of DPP-compatible media in Vantage.

The purpose of the DPP Portal is to enable operators to assemble and produce SD or 
HD media files that conform to the current DPP standard, for broadcast in the UK 
market.

This configuration can only be used in the Workflow Portal Windows client. 

You use a DPP Portal to browse catalogs and select binders from completed ingest 
workflows jobs, enter metadata and mark programme parts, then generate DPP-
compliant media which comprises the programme. A DPP configuration defines each 
field of DPP metadata in the programme, which may be given a default value, and may 
be marked as read-only.

The DPP portal is designed to allow you to:

• Create a DPP programme containing one or more segments

• Enter DPP metadata to accompany that programme

• Create a DPP XML file and a Composition (CML) file from which to generate the 
programme’s media file (with Post Producer) and transcode to AS-11 with DPP 
metadata (with a Vantage Transcode Pro license).
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Note: You can add a DPP Validate action (located in the Analysis group) to your target 
workflow to validate metadata in a DPP package.

After you have prepared the media you want to include in the package, you open 
Workflow Portal with the proper DPP configuration to create your DPP package, enter 
metadata as required, and submit it for processing. 

The DPP Portal automatically generates a CML file that defines the media, unless the 
operator provides a custom CML. The CML file and all related media files are submitted 
to the target Vantage workflow for producing the package.



Using Workflow Portal Configurations
VOD | DAI Portal Overview

76

VOD | DAI Portal Overview
Note: The VOD Producer | DAI User Guide is also provided for complete details 
regarding the encoding media for VOD markets using VOD Producer Vantage.

The purpose of the VOD | DAI Portal is to enable operators to prepare source media and 
automate:

• CableLabs-compliant stream-conditioned media generation

• Canoe/BlackArrow-compliant dynamic ad insertion (DAI) location definition CSV 
(comma-separated value) files for local and national ads

• Nielsen audio watermarking.

VOD Producer performs media encoding and conditioning and Nielsen watermarking, 
along with automated delivery of programs and advertisements to MVPDs, and 
metadata to ecosystem partners in supporting workflows.

This configuration can only be used in the Workflow Portal Windows client. 

Note: You can also process CML and EDL files with automated VOD Producer and 
VOD Producer DAI workflows to produce VOD assets, without using VOD Portal. These 
are implemented using Vantage automation workflows, and are covered in the Post 
Producer Developer's Guide.

Generating and delivering VOD assets in VOD Producer involves at least two Vantage 
workflows. The diagram following illustrates the general process an operator follows to 
prepare, generate, and deliver VOD assets.
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First, an operator selects a single file or a set of source media files, and submits them to 
an ingest workflow, supplying metadata as appropriate. The ingest workflow creates 
frame-accurate proxies and processes the metadata. It registers each source media file 
and its metadata, proxy, and keyframes in a catalog for access in VOD Portal.

Next, using VOD Portal, the operator selects and prepares source media for submission 
to the publication workflow. 

In VOD Portal, the operator performs the following tasks as appropriate:

• Select and identify segments in source media

• Add interstitials for promotion and cross promotion

• Define frame-accurate locations and value for dynamic ad insertion

• Brand each segment

• Add SCC file to clips as appropriate

• Configure V-chip settings and graphics

• Specify copy protection requirements

• Specify where to insert local and/or national ads—Segment, Head, or OTT, and pre-
roll, post-roll, or mid-roll, or lead black. 
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The operator then submits the job to a publishing workflow, which performs these 
operations:

• Assembles the playlist composition

• Encodes the media as a CableLabs-compliant transport stream, optionally encod-
ing to adaptive bit-rate or mezzanine formats

• Optionally, watermarks the audio for Nielsen measurement, produces Nielsen 
metadata and creates Nielsen documents

• Optionally, produces ad metadata and creates DAI location definition files for 
Canoe/BlackArrow

• Simultaneously distributes the VOD asset to the MVPD and delivers the metadata 
associated with the asset to ecosystem partners (Nielsen and Canoe).
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Tempo Portal Overview
Note: The Tempo User Guide is also provided for complete details regarding re-timing 
media using Tempo.

The Tempo Portal enables operator-driven re-timing of media assets—intelligently 
decreasing or increasing the running time of shows and segments by up to ten percent.

This configuration can only be used in the Workflow Portal Windows client.

Re-timing assets in Tempo involves at least two Vantage workflows. The diagram 
following illustrates the general process an operator follows to prepare and re-time 
media assets.

First, an operator selects a single file or a set of source media files, and submits them to 
an ingest workflow. The ingest workflow creates frame-accurate proxies and optionally 
re-encodes the media to meet Tempo-processing requirements. It registers each source 
media file and its proxy and keyframe in a catalog for access in Tempo Portal.
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Next, using the Tempo Portal, the operator selects and prepares source media for 
submission to the publication workflow. 

In Tempo Portal, the operator performs the following tasks as appropriate:

• Browse clips in the selected Vantage catalog.

• Drag clips into a segment list and view them in a built-in video player. 

• Mark In/Out to identify clip segments and include/exclude them from re-timing.

• Add a graphic overlay (bug) and/or content rating graphic to one or more clips.

• Set exact overall clip duration, or increase/decrease clip time by a percentage.

The operator then submits the job to a publishing workflow, which re-encodes the 
media, re-timing it in the process, per the instructions specified in the XML file auto-
generated by Tempo Portal.
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Syndication Portal Overview
Note: The TrafficManager User Guide provides complete details about TrafficManager 
automated and operator-managed processing of syndicated material for broadcast.

Syndication Portal configurations can be used only in the Windows Workflow Portal 
client, not in the web client.

The Syndication Portal enables operators to review and prepare syndicated (long-form/
episodic) media for submission to a publishing workflow to encode it for broadcast, 
including these tasks:

• Metadata label review and update

• Segment list review based on a template, and update as required.

Generating syndicated assets in TrafficManager via Syndication Portal involves at least 
two Vantage workflows. The diagram following illustrates the general process to 
prepare, generate, and deliver syndicated assets to a broadcast server.
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First, an ingest workflow is triggered by an operator submitting a file, dropping it into a 
monitored folder, or automatically, via a catch server. The ingest workflow typically 
creates a frame-accurate proxy and a thumbnail, and transforms the metadata sidecar 
file into a mezzanine file for use in other Vantage workflows. It registers each source 
media file and its metadata, proxy, and keyframe in a catalog for access using the 
Syndication Portal.

Next, in the Syndication Portal, the operator selects and prepares source media for 
submission to the publication workflow.

In the Syndication Portal, the operator performs the following tasks:

• Selects and reviews segments, updating attributes, adjusting timing and segment 
order, adding/modifying spots, joining/unjoining commercial segments, etc.

• Reviews any metadata labels, updating as necessary

• Submits the media to one or more publishing workflows.

When the operator submits the media, in Stitching and Segmenting modes, two files 
are auto-generated by the Syndication Portal: an updated mezzanine metadata XML 
file, and a CML file. However, in Pass-Thru mode generates a new XML file, but does not 
generate a CML file. Instead, it passes the source media from the ingest workflow—
which must be nicknamed Original— to the publishing workflow, so that the program 
can be transcoded without having to change the program's timeline.



Using Workflow Portal Configurations
Syndication Portal Overview

83

A typical Automation workflow uses the metadata file to perform these essential tasks:

• Uses the Automate action to convert the mezzanine metadata XML file into the for-
mat required for a given automation system (ASDB or Bxf, for example).

• Delivers the entire payload to the automation system. 

A typical on-air server workflow uses the CML file to perform these essential tasks:

• Assembles the playlist composition into the broadcast media format required, 
using a Conform action (which requires a Post Producer license).

• Delivers the encoded media to a broadcast server.

For more information on using the Syndication Portal, see Implementing Syndication 
Portal Media Processing in this guide and also see the TrafficManager User Guide.
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Ingest Workflow Considerations
The ingest workflow for this portal follows the same pattern as other portals. Ingested 
assets must be registered into a Vantage catalog by the Register action before they will 
become visible in the catalog and available for use in the Workflow Portal. A thumbnail 
image is recommended (for clip icons) and a QuickTime H.264/AAC MOV or x264/AAC 
MP4 proxy file is required to be registered into a catalog and given the nicknames 
Vantage Thumbnail and Vantage Proxy, respectively. 

In the example below, a Watch action accepts the input media and forwards it to Flip 
actions that format the media into thumbnail and proxy files, and pass these files on to 
a Register action that adds the files to a catalog. The catalog can be accessed by the 
portal where operators can view and manage the files.

An Analyze action after the Watch action can be used to extract Letterbox Detection 
and Curtain Detection metadata from the media and put it into variables. The Vantage 
Editorial metadata label includes parameters for crop top, bottom, left, and right which 
are bound via a Populate action to the variables.

Once included in the workflow, the metadata and variables can be viewed in the portal, 
and operators can manually update them as desired.
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The following figure shows Analyze and Populate configuration examples that enable 
metadata visibility in the Logging Portal Metadata Labels tab.

The Analyze action can also automatically detect black segments used as spacers 
between content segments and generate an Analysis Result attachment. As shown 
below, the Logging Portal Segment List tab detects the Analysis Result attachment and 
populates the segment list with the detected content segments.
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Target Publishing Workflow Considerations
The clip log target workflow must begin with a Receive action. The Receive action 
accepts the clip list attachment and media file and must emit the previously specified 
General Attachment or Generated CML nickname (such as XML or CML). Additionally, 
the Receive may optionally emit the Original media version nickname. 
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Using Workflow Portal

Vantage Workflow Portal is a client program (also available as a web app) designed for 
customizable, operator-driven media processing. Several Workflow Portal 
configurations are provided to implement specific operational needs. The 
configurations allow you to customize functionality and the user interface and 
generate a specific output (for example, DPP configurations). 

You create and configure Workflow Portal configurations in the Vantage Management 
Console, and load them in Workflow Portal when you launch it to perform specific 
media processing tasks.

Note: Workflow Portal is an optional, licensed Vantage feature. For licensing details, 
refer to http://www.telestream.net/telestream-support/vantage/vantage-
licenses.htm. These topics apply to both clients, except where noted. For information 
on using each configuration type, see Using Workflow Portal Configurations.

The Windows client provides optimum performance and the full feature set. You can 
use the Workflow Portal web app. on any computer with a supported web browser (see 
Web Application Browser Requirements) and a network or Internet connection to your 
Vantage domain. Not all configuration types are supported in the web app. 

Topics
■ Workflow Portal Overview

■ Workflow Design Guidelines

■ Starting a Workflow Portal Session

■ Changing or Reloading a Configuration

■ Managing Workflow Portal Projects

■ Performing Workflow Portal Tasks

■ Windows Client Menus

■ Web Client Menus

■ Troubleshooting Workflow Portal

http://www.telestream.net/telestream-support/vantage/vantage-licenses.htm
http://www.telestream.net/telestream-support/vantage/vantage-licenses.htm
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Workflow Portal Overview
Video processing applications frequently require some form of operator intervention 
during media processing. For example, an operator might run media through an ingest 
workflow to create a proxy to check timecode and closed captions and scrub and set 
trim points, review and add/edit metadata and variables, and then submit (or forward) 
the media to another workflow to start a production processing job.

Note: For basic information on using Vantage client programs, see Vantage Client 
Programs Overview.

Note: On Windows Server 2008, you may have problems minimizing windows that 
you maximize by dragging to the top of the monitor (AeroSnap). To disable AeroSnap, 
go to Control Panel > Ease of Access Center > Change how your mouse works. Check 
Prevent windows from being automatically arranged when moved to the edge of the 
screen.

■ Key Applications

■ How Workflow Portal Works

■ Key Workflow Portal Features

■ Workflow Portal Configuration Types

■ Implementing Workflow Portal-based Media Processing

■ Implementing Syndication Portal Media Processing

Key Applications
Key applications of Workflow Portal include:

• Highlight Extraction From Archive Files—An operator marks in and out timecodes 
and chooses the timecode for a thumbnail, and processes the media in a workflow 
the creates the clip.

• Promo Preparation—An operator marks the voice-over and graphics entry points 
on the timeline. A subsequent workflow reprocesses the promo for multiple mar-
kets, days, and languages, based upon this input.

• Clip Stitching—An operator can select media files of various metrics and define clips 
within that media, then submit the EDL to a stitching workflow to combine the 
clips and render them into a single output file.

• VOD Distribution—An operator creates a playlist of clips and enters metadata. A 
subsequent workflow merges (stitches) the clips into a single media file and trans-
forms metadata for distribution.

• VOD Digital Ad Insertion—An operator defines national and local ad locations for 
dynamic ad insertion by the cable vendor, and submits jobs for assembly of Cable-
Labs VOD content and provisions it for dynamic ad insertion (DAI).
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• TrafficManager—An operator searches catalogs, then reviews and submits com-
mercial inventory for processing to a specific publishing workflow.

• TrafficManager Syndication—An operator reviews catalogs and submits syndicated 
inventory to a specific publishing workflow. See the TrafficManager Guide for operating 
details.

• DPP Package Preparation—An operator enters DPP metadata, marks programme 
segments, and submits the assets to a workflow. Vantage adds bars, generates 
slates, and encodes to the appropriate MXF format with DPP metadata to create a 
DPP package.

• CML Preparation—An operator creates clips, and submits the auto-generated com-
position (CML file) to a Conform-based workflow to generate the specified output.

• Re-timing of assets— An operator selects a media file and submits it to a Tempo-
based workflow for re-timing— intelligently decreasing or increasing the running 
time of shows and segments. Tempo utilizes new time compression algorithms that 
deliver superior quality and faster turn-around times.

How Workflow Portal Works
This figure depicts how Workflow Portal is typically used in a Vantage domain.

Operator-access to job variables and media metadata is a powerful feature that enables 
operators to control the operation of the next workflow. For example, operators can 
edit embedded and label metadata parameters, modify variables to control content 
routing, or select other processing options in the next workflow.

Workflow designers and Vantage 
administrators create workflows 
and Workflow Portal 
configurations for operators.

Operators use Workflow Portal to review media 
in catalogs, update metadata, trim points, and 
other data, and submit media to workflows.
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Key Workflow Portal Features
Workflow Portal provides several features for performing operator-intervention media 
processing workflows. Workflow Portal has a customizable user interface where 
components and features are controlled by a configuration file, created in the 
Management Console, and loaded in Workflow Portal when launched by an operator.

Depending on your application and configuration, these features allow operators to:

• Browse Vantage catalogs and servers for media (registered in binders) from com-
pleted jobs to process.

• Create an Edit Decision List (EDL) of clips for stitching with a Flip action workflow 
(Windows client only).

• Create a Composition file (CML) of clips for stitching with a Post Producer Conform 
action workflow (Windows client only).

• Create/review/update XML-based or label-based metadata.

• Review/edit embedded metadata.

• Preview/scrub media proxies.

• Mark in/out trim points on an asset’s timeline.

• Perform playback of selected segments.

• Mark media as approved or rejected.

• Supply run-time values to variables to use in the next workflow.

• Submit (forward) the media to workflows for further processing.

Workflow Portal Configuration Types
Vantage provides several configuration types. Each type has specific functionality, 
implementing a common media processing application. Here are the configuration 
types as specified in the management console, along with their common names:

• Browse Catalogs (copy binder)—Copy Binder Portal

• Browse Catalogs (forward binder)—Forward Binder Portal

• Browse Windows Network (create binder)—Windows Portal

• Create EDL from Catalogs (create binder)—EDL Portal

• Create CML from Catalogs (create binder)—CML Portal

• Create DPP from Catalogs (create binder)—DPP Portal

• Create VOD from Catalogs (create binder)—VOD Portal

• Re-time Asset from Catalogs (create binder)—Tempo Portal

• Syndication—Syndication Portal

The names on the left match the names a domain administrator sees when creating 
and setting up a Workflow Portal configuration, using the management console. The 
names after the dash are the common names used in this and other guides.
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Note: Some configurations can only be used in the Windows client. Others are 
available in both the Workflow Portal web client and the Windows client. 

The Copy Binder and Forward Binder, as well as the Create EDL, CML, DPP, Tempo, and 
VOD configurations allow operators to browse Vantage catalogs and select binders that 
have been registered by a previous job for processing.

The Browse Windows Network configuration allows operators to browse a Windows 
server (not a Vantage catalog) to select media files. (Binders only exist in the context of 
a Vantage catalog.)

Each type of configuration causes Workflow Portal to operate differently, to achieve its 
intended result. The operation of the basic configurations are explained in detail in 
Using Workflow Portal Configurations. Configurations offered as Vantage editions are 
described in a separate user guide.

Each of the configuration types are summarized in these topics:

■ Browse Catalogs Copy Binder and Forward Binder Configurations

■ Browse Windows Network Configuration

■ Create EDL from Catalogs Configuration

■ Create CML from Catalogs Configuration

■ Create DPP from Catalogs Configuration

■ Create VOD from Catalogs Configuration

■ Re-time Assets from Catalogs Configuration

■ Syndication Configuration

Browse Catalogs Copy Binder and Forward Binder 
Configurations
The purpose of both Browse Catalogs configurations is to enable operator-intervention 
media processing on Vantage catalog-based media. That is, the media has already been 
processed by a Vantage workflow and registered in the catalog, potentially along with 
other job-related assets: attachment files, metadata labels, etc. The operator can enter 
and edit label-based metadata for the selected media, and also update variables as 
required for the workflow. Browse Catalogs configurations are intended for processing 
a single file; they do not support creation of a clip list and stitching.

Both types of configurations are supported in the Workflow Portal web app and the 
Workflow Portal Windows client.

In a Browse Catalog Copy Binder Portal, the operator can browse catalogs, select a 
binder and submit a job to a workflow to process the media—after clicking the Submit 
button. When the operator clicks the Submit button, the selected binder is copied—
duplicated and used only as a template for the current job—leaving the original binder 
unchanged and intact in the catalog for future use or re-submittal. The job (as always) 
creates a binder during execution; it may or may not be registered by the workflow into 
a catalog for further utilization.
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In contrast, in a Browse Catalogs Forward Binder Portal, the operator browses a catalog 
and selects a binder—before clicking the Submit button. The selected binder (with any 
changes the operator makes) is submitted to the workflow—without making a copy. 

Forward binder mode allows the workflow to modify the contents of the original 
binder, and those modifications will be visible the next time the user refreshes the 
binder in the portal.

Browse Windows Network Configuration
The general purpose of the Browse Windows configurations is to enable operator-
intervention on media processing, where the media files are stored directly on a 
Windows platform. The operator can review and edit label-based metadata for the 
selected media, and also update variables as required for the workflow. 

The Browse Windows configuration is supported only in the Windows client.

The Browse Windows Network Portal (Windows Portal for short) allows you to select 
one or more media files from servers on a Windows network and submit them to target 
workflow(s). The job (as always) creates a binder during execution; it may or may not be 
registered by the workflow into a catalog for further utilization.

Create EDL from Catalogs Configuration
The EDL Portal enables you to automatically create an Edit Decision List (EDL) which the 
operator submits to a Flip-based workflow to process the EDL. When creating an EDL, 
the operator selects the media files to submit by browsing Vantage catalogs and 
selecting one or more binders created from previously-completed jobs. 

The Create EDL from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

You can mark start and end points to clip your input media files, and then stitch the 
selected clips together in the workflow to which you submit the EDL. The EDL 
configuration publishing workflow must use the Flip action to stitch and encode the 
media. The EDL Portal requires that all clips have the same frame rate, frame size and 
video codec.

The operator can also review and edit label-based metadata for the selected media, 
and also update variables as required for the workflow. The job creates a new binder 
from assets in or more source binders and updates it during execution; it may or may 
not be registered by the workflow into a catalog for further utilization.

Create CML from Catalogs Configuration
The CML (Composition Markup Language) Portal is designed to automatically create a 
Composition (CML) file that defines an EDL—the set of clips you’ve added from media 
registered in catalogs, which you submit to a Post Producer publishing workflow with a 
Conform action. The Conform action processes the composition, stitching the clips and 
renders a single media file as output, based on the specifications in the CML.
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The Create CML from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

While the EDL Portal requires that all clips have the same frame rate, frame size and 
video codec; the CML Portal does not have this restriction. CML processing by Conform 
also improves VANC and caption processing.

The operator can review and edit label-based and embedded metadata for the selected 
media, and also update variables as required for the workflow. The job creates a new 
binder from assets in or more source binders and updates it during execution; it may or 
may not be registered by the workflow into a catalog for further utilization.

Create DPP from Catalogs Configuration
The purpose of the DPP Portal is to enable operators to assemble and produce media 
files that conform to the current DPP standard, for broadcast in the UK market.

The Create DPP from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

You use a DPP Portal to browse catalogs and select binders from completed ingest 
workflows jobs, enter metadata and mark programme parts, then submit it to a 
publishing workflow to generate DPP-compliant media which comprises the 
programme. A DPP configuration defines each field of DPP metadata in the 
programme, may be given a default value, and may be marked as read-only. In 
addition, the portal may be configured for either SD or HD.

The job creates a new binder from assets in or more source binders and updates it 
during execution; it may or may not be registered by the workflow into a catalog for 
further utilization.

Create VOD from Catalogs Configuration
The VOD Portal is designed to enable operators to prepare VOD assets, including digital 
ad insertion, metadata, captioning, ratings, branding, and copy protection, and submit 
them to a publishing workflow that encodes VOD assets and deliver them to multi-
channel video programming distributors (MVPDs).

The Create VOD from Catalogs configuration is supported only in the Workflow Portal 
Windows client.

You use a VOD Portal to browse catalogs and select binders from completed ingest 
workflows jobs, enter metadata and mark programme parts, then generate CableLabs-
compliant media. The operator can review and edit label-based and embedded 
metadata for the selected media, and also update variables as required for the 
workflow. The job creates a new binder from assets in or more source binders and 
updates it during execution; it may or may not be registered by the workflow into a 
catalog for further utilization.
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Re-time Assets from Catalogs Configuration
Use Tempo Portal to browse catalogs and select source media that you want to re-time, 
create and mark clips to include or exclude from re-timing, and specify how much time 
expansion or compression to apply. 

The Re-time Assets from Catalogs configuration (commonly called the Tempo 
configuration) is supported only in the Workflow Portal Windows client.

When re-timing configuration is complete, the Portal generates a composition to 
describe that processing. The operator selects a Tempo workflow to process the CML, 
and the Tempo action in the workflow implements media file re-timing. The job creates 
a new binder from assets in or more source binders and updates it during execution; it 
may or may not be registered by the workflow into a catalog for further utilization.

Syndication Configuration
Use the Syndication Portal to browse catalogs containing syndicated media and select 
the media that you want to review, update, and process in TrafficManager for 
broadcast. 

The Syndication configuration is supported only in the Workflow Portal Windows client.

The Syndication Portal displays the selected media in a segmented view, based on the 
timing information obtained from the original syndication source (for example, 
PitchBlue).

When your review and configuration of segments and their attributes is complete, the 
Portal generates a new mezzanine metadata XML file as well as a composition (CML) 
file. The operator selects a publishing workflow to process either the mezzanine 
metadata file or the CML file for broadcast.

When using Pass-Thru mode, the Syndication Portal does not generate a CML. In Pass-
through mode, the Portal generates an XML (similar to the other modes), but in 
addition passes the source media from the ingest workflow—which must be 
nicknamed Original— to the publishing workflow, so that the program can be 
transcoded without having to change the program's timeline.
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Implementing Workflow Portal-based Media Processing
Implementing Vantage workflows that are intended for use with Workflow Portal 
requires planning and coordination by your Vantage administrator and workflow 
designer. To implement a Workflow Portal-based workflow, a Vantage domain 
administrator must first use the Vantage Management Console to do the following:

• Enable the utilization of Workflow Portal.

• Configure one or more Workflow Portal configurations, which define the Workflow 
Portal feature set for the specific application, including the components, features, 
and resources available to operators. This includes metadata and variables, and 
must be coordinated with the workflow designer to utilize the metadata and vari-
ables as appropriate for your application.

Note: Administrators who are responsible for creating Workflow Portal configurations 
should refer to the Vantage Domain Management Guide for details.

Workflow designers use Workflow Designer to create and configure the required 
workflows, including required metadata and variables, and activate them when you 
want to use them in testing or production.

Typically, a given media processing application involves at least 2 Vantage workflows:

• An ingest workflow, which transcodes media as required and registers it in a catalog 

• A publishing workflow, which processes the media the operator has selected and 
forwarded to the workflow to encode it for publication.
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Implementing Syndication Portal Media Processing
The Syndication configuration of the Workflow Portal is described in detail in the 
TrafficManager User Guide, including operating details and workflows. The following 
steps summarize how to use the Syndication Portal (TrafficManager option required).

1. Create a syndication catalog using Management Console > Catalogs. 

2. Create a new syndication template using the Vantage Management Console > 
Syndication folder > Templates feature. Use the Populate from XML button to import 
an XML metadata file for the show and then adjust the show segments, if needed.

For template configuration details, see the Vantage Domain Management Guide.

3. Create an ingest workflow that includes an origin action (Catch, Receive, Watch/
Associate) capable of ingesting and localizing a syndicated media file and its 
sidecar metadata file. 

Also use Flip actions to create thumbnail and proxy files.

Include a Syndicate action to apply the template to the sidecar file, producing a 
mezzanine file nicknamed Syndication. 

Include a Register action to register the files into a binder for entry into the syndica-
tion catalog. The catalog must contain media nicknamed Original, a proxy, and a 
syndication metadata attachment nicknamed Syndication as required inputs to the 
Syndication Portal. (Note that only XML files for programs require the Syndication 
nickname; commercial files do not.)

The portal can then be used to access the binder and its files from the catalog. 

4. Create a publishing workflow. Typically, you’ll want to start with a Receive action to 
accept the files submitted from the portal and an Automate or Conform action to 
convert the XML or CML files and the syndicated media to the desired formats. 

In Automate, you can select BXF or other automation formats for outputting to an 
automation system. 

Note: The Syndication nickname is required for the attachment file in both the 
Receive and Automate actions, and the CML nickname is also required by the 
Receive action in Stitching or Segmenting mode.

5. Create a Syndication Portal configuration using the Vantage Management Console 
> Application Configuration > Workflow Portal. Set the Mode to Syndication, and 
set the parameters in each tab. In Syndication Settings, specify the template you 
created as the Default template. Also select a Syndication mode:

Stitching mode: Submitting from the portal generates a single CML file and a sin-
gle Syndication XML file for the whole program. Stitching mode requires all seg-
ments to be normalized to the same frame rate. 

Segmenting mode: Submitting from the portal creates a separate job for each 
included segment. A CML file and a Syndication XML file are created for each job.

Pass-Thru mode: Submitting from the portal does not create a CML. Instead, the 
Original from the ingest workflow is made available to the publish workflow and a 
Syndication XML is generated based on the Segment List. On the Forward To Work-
flows tab, select (Add) the publishing workflow. 
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6. Open the Workflow Portal and use File > Change/Reload Application Configuration 
to load the Syndication Portal configuration created earlier. Refresh the catalogs, 
select the syndication catalog, and drag one or more binders into the Segment List. 

Use the portal to preview and adjust segments manually.

7. Forward the updated show to the publication workflow by accessing the Forward 
To Workflows tab, selecting the workflow, and clicking Submit.

Media and metadata files are delivered to your automation system in ready-to-use formats. 

Note: After you fine-tune the segments of a show, you can save the template from 
the portal using the Create Template button. 

You also have the option when creating workflows to completely bypass the 
Syndication Portal, combine ingest and publishing into a contiguous workflow, and 
process all the files without human intervention. 
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Workflow Design Guidelines
This topic is for those who are designing and implementing workflows. It provides 
general guidelines for creating workflows intended for use in Workflow Portal 
applications.

Note: In addition to these general guidelines, there may be application-specific 
guidelines that must also be followed. These guidelines are noted in their respective 
topics in Using Workflow Portal Configurations for basic configurations; for product-
specific guidelines, see the Tempo User Guide or the VOD Portal User Guide.

While you can use a single workflow to produce and distribute media, there are some 
media processing applications which require operator intervention using Workflow 
Portal, thus dividing the media processing into multiple workflows. Operator 
intervention tasks include QA, building clip lists, and for adding/editing metadata and 
variables prior to job submission for further processing.

Workflows for use in conjunction with Workflow Portal typically fall into two categories: 
ingest and publishing. 

For example, an ingest workflow can automatically analyze source media and detect 
media attributes and characteristics such as frame rate, dimensions, letter boxing, and 
macro blocking. Ingest workflows often encode media into the required format for use 
in the publishing workflow. You typically use Register actions in the ingest workflow, to 
create binders in Vantage catalogs, which operators will browse for files to process.

Ingest workflows can also produce proxy media that you can view with the Workflow 
Portal media player to evaluate quality issues and quickly define timecodes for trim 
points or commercial insertion, for example.

A publishing workflow is a workflow designed to process media submitted by Workflow 
Portal operators. Publishing workflows always start with a Receive action so that 
operators can submit jobs to them (and they must be running). When your application 
calls for an ingest workflow, you use Workflow Portal to evaluate the ingest workflow 
results, take any action required, and then submit the job to a publishing workflow. 
Frequently, a given application has more than one publishing workflow. 

You can also chain publishing workflows, providing operator intervention at more than 
one point in the process.

You might use Workflow Portal in a Browse Windows Network configuration, where 
your process may not require an ingest workflow. You can use Workflow Portal to select 
media, edit metadata and variables and submit jobs to a publishing workflow, rather 
than just placing media files in a watch file for automated processing. The advantage to 
operator submission is that you can set metadata and variables during submission, 
providing more control over publishing workflow processing.

These topics provide guidelines for creating workflows for use with Workflow Portal:

■ Ingest Workflow Guidelines

■ Publishing Workflow Guidelines
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Ingest Workflow Guidelines
When you use any Workflow Portal configuration other than Browse Windows Network, 
an ingest workflow, you must use an ingest workflow with a Register action (which 
should be located after all transcoding, and any metadata and variable modifications in 
the workflow), to create a binder in a catalog. One binder is created for each job that 
executes. In addition to referencing each file ingested or created in the workflow, 
metadata labels which you specify are stored in the binder, along with variables. 

You can use the special nicknames Vantage EDL, Vantage Proxy, and Vantage Thumbnail 
in Workflow Portal ingest workflows Flip action for identifying specific-purpose files:

• Vantage EDL—in the Program Stream and Transport Stream encoders, for EDL con-
figurations.

• Vantage Proxy—in the QuickTime and MP4 encoders, for all configurations which 
create clip lists and/or utilize the media player to scrub media

• Vantage Thumbnail—in the Keyframe encoder for configurations where you can 
browse catalogs.

When you browse catalogs in Workflow Portal, you can view binders created by each 
job, giving you access to all resources defined in the binder, including the source media.

When building ingest workflows, observe the following general guidelines:

• Register Action Requirements—to make a binder available to Workflow Portal opera-
tors in any catalog-enabled configuration, use a Register action to save the binder 
in the appropriate catalog.

• Workflow Portal Windows Client Media Player Requirements—Use the Flip action to 
create a proxy file, using the nickname Vantage Proxy. Required format:

– QuickTime encoder, H.264 video codec, AAC audio codec, QuickTime 7.6.9 
installed

OR

– MP4 encoder, x264 video codec, AAC audio codec, QuickTime 7.7.6 installed

– See Previewing Proxy Media in the Media Player for additional proxy format details.

• Make sure that your encoded proxy file is the same frame rate and timecode nota-
tion as your production media. Configure container settings to generate a time-
code track to support the Use Clip Start Time feature. You can also burn in the 
timecode to make sure it is present.

• Workflow Portal Web Client Media Player Requirements—Use the Flip action to create 
a proxy for previewing in the HTML5 media viewer. The required format is:

Encoder: MP4 Encoder

Video Codec: x264

Audio Codec: AAC

Container: MP4 File

Make sure that your encoded proxy file is the same frame rate and timecode nota-
tion as your production media.
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• Proxy Viewing—to enable a selected binder’s media file to automatically display in 
the Workflow Portal media viewer, assign the Vantage Proxy file nickname to the 
media file. 

• Catalog Viewing—To support operator viewing of binders by thumbnail (instead of 
by name), configure a Flip action with the Keyframes encoder to create a thumbnail 
that uses the Vantage Thumbnail file nickname.

• Metadata and Variables—To make media information available to operators for ver-
ification or editing, configure an Analysis action (or a Workorder action for submit-
ting multiple jobs at one time, with metadata) to collect the information in 
variables. Use a metadata label to store this information in a binder to pass the val-
ues to another workflow indirectly. For example, an operator submits a job to a 
publishing workflow in Workflow Portal.

Publishing Workflow Guidelines
Unlike ingest workflows, publishing workflows can be designed and configured in 
almost any way you require. Few limits are imposed on the design of a publishing 
workflow that is used by Workflow Portal.

When you configure publishing workflows, follow these guidelines:

• The publishing workflow must start with a Receive action or other action that 
allows an operator to directly submit media to the workflow for processing.

• The publishing workflow should be configured to accept and process any metadata 
labels and variables that an operator enters, or that pass through from the ingest 
workflow jobs.

• The publishing workflow must use the type of transcoding action required to pro-
duce the output media you want and the Workflow Portal configuration you’re 
using. For example, an EDL Portal job requires a Flip action, while a CML Portal con-
figuration requires a Conform action.

There may be additional requirements for various configurations. See the respective 
configuration topic in Using Workflow Portal Configurations or available app notes or 
guides on the topic.
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Starting a Workflow Portal Session
The following topics describe how to start sessions with the Workflow Portal clients, 
and how to load a different configuration:

■ Starting a Session with the Windows Client

■ Starting a Session with the Web Client

Starting a Session with the Windows Client
To start a session with the Workflow Portal Windows client, do the following:

1. Start the Windows client as described in Starting Workflow Portal.

2. If you are prompted to select a Vantage domain, select a domain as described in 
Selecting a Vantage Domain.

If you do not know the Vantage domain name, contact your Vantage domain 
administrator.

3. If you are prompted to enter a Vantage user name, log in as described in Changing 
Vantage Users in Windows Client Programs.

If you do not know your Vantage user log in information, contact your Vantage 
domain administrator.

4. If you are prompted to select a Workflow Portal configuration, select the 
configuration you want to use for this session.

To change the Workflow Portal configuration, see Changing or Reloading a 
Configuration.

Starting a Session with the Web Client
To start a session with the Workflow Portal web client, do the following:

1. Start the web client as described in Web App Home Page—Launching Web Apps.

2. If you are prompted to select a Vantage domain, select a domain as described in 
Logging In or Changing Domains from Web Applications.

If you do not know the Vantage domain name, contact your Vantage domain 
administrator.

3. If you are prompted to enter a Vantage user name, log in as described in Changing 
Vantage Users in Web Applications.

If you do not know your Vantage user log in information, contact your Vantage 
domain administrator.

4. If you are prompted to select a Workflow Portal configuration, select the 
configuration you want to use for this session.

To change the Workflow Portal configuration, see Changing or Reloading a 
Configuration, below.
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Changing or Reloading a Configuration
You can change Workflow Portal configurations while you are running Workflow Portal.

If a Vantage domain administrator updates a Workflow Portal configuration while you 
are using it, the program continues to use the configuration as it was when you 
selected it. To obtain the updated version, reload it when advised by the administrator.

■ Changing/Reloading a Configuration in the Windows Client

■ Changing/Reloading a Configuration in the Web Client

Changing/Reloading a Configuration in the Windows Client
To change or reload a configuration in the Windows client, do the following:

1. Select File > Change/Reload Application Configuration.

2. When the Select Configuration dialog appears, select a configuration to use and 
click OK.

Changing/Reloading a Configuration in the Web Client
To change or reload a configuration in the web client, do the following:

1. Select Portals.

2. Select the configuration to which you want to change.

3. When the confirmation dialog appears, click OK.
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Managing Workflow Portal Projects
In any Workflow Portal configuration in the Windows client, you can select media and 
set up a job (with clips, metadata, variables, etc.) and submit it, then start over with new 
media for the next job, etc. You can also start working on a new job, and then save it, 
and open it later to complete the work and submit it for processing. 

In Workflow Portal, the collective settings are referred to as a project. Using projects in 
Workflow Portal is similar to opening and working on files in Microsoft Word or Excel. 
You can create, edit, save, and re-open them any time you want.

Note: Projects are only valid for the domain they are created in and the Workflow 
Portal configuration they were saved from. You can not save projects from one domain 
and re-open the project for use in another domain. You also can not re-open a project 
if the configuration from which it was saved has been deleted from the domain.

■ Creating a New Project

■ Saving a Project

■ Saving a Project With Another Name

■ Opening a Project

Creating a New Project
To create a new project in Workflow Portal, select File > New Project, or select the New 
Project (+) button in the upper left corner of the Segment List tab.

Creating a new project is just like opening Workflow Portal and starting work. No media 
has been selected, no clips (if enabled) have been created or configured, and no 
metadata or variables have been modified. Everything is reset.

Creating a new project is handy if you are working continuously on selecting media 
and preparing it for submission to a workflow, then getting ready to select new media 
and starting another job: It clears out everything so you can start over again.

You can also create a new project when you have made an error that is not easy to fix, 
or you just want to start over with a clean slate.

You don’t have to create a new project just because you may want to save it later.
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Saving a Project
To save work you are performing on a given set of media, select File > Save Project.

When you save a project, Workflow Portal displays a File Save dialog. You can name the 
XML file anything you want, and save it where ever you want.

Note: Unlike other Vantage resources—workflows, Workflow Portal configurations, 
variables, etc. which are all stored in the Vantage domain’s database—Workflow Portal 
projects are stored as XML files in a Windows directory of your choosing, just like any 
other program’s data files.

Each time you save the project after the first time, it just updates the project file.

You can re-open it later using the Open Project command.

Saving a Project With Another Name
To save a project you have open under another name, select File > Save Project As. 
Workflow Portal displays a File Save dialog. You can rename the XML file anything you 
want, and save it where ever you want.

You can re-open it later using the Open Project command.

Opening a Project
To open a project that has been previously saved, select File > Open Project. Workflow 
Portal displays the Open File dialog. Navigate to the file and click Open.
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Performing Workflow Portal Tasks
The following topics describe how to use the components that comprise Workflow 
Portal, to perform these basic tasks:

■ Browsing Catalogs for Media

■ Selecting a Binder

■ Previewing Proxy Media in the Media Player

■ Creating Clip Lists/Segments

■ Editing Metadata Labels

■ Specifying Variable Values

■ Specifying Forwarding Workflows

■ Submitting Jobs in the Windows Client

■ Submitting Jobs in the Web Client

Browsing Catalogs for Media
You can browse catalogs and select media in binders in all configurations except 
Browse Windows Network configurations.

Note: The binder list doesn’t automatically update when binders are added or 
deleted as workflow jobs execute. To update the list, click the Refresh button at the 
top of the Binder table.

Depending on your configuration, you may be able to perform the following:

• Browse and select binders from multiple catalogs

• Select specific media in a binder for submission

• View the list of media in a selected binder

• Manually delete binders
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Selecting a Binder
To select a binder, do the following:

1. If the Catalogs panel (in the top left corner of the window) displays, select the 
catalog or catalog folder you want to browse.

Note: The catalogs that you can access are specified in the configuration. The catalog 
browser may be hidden, when the configuration only allows access to one catalog, 
with no subfolders.

2. In the Binder table (directly above the tabbed workspace—upper right—displays 
the name of the catalog you are browsing), select the binder that you want to view.

In the Windows client (see below), use the Filter menu, located directly above the 
Binder Details panel, to help you filter binders. Use the Details menu (far right) to 
select Details or Thumbnails view.

The columns that display in this table are controlled by the configuration, and may 
include Binder Name, Created, Expiration, and the Play button and Submit button, 
and others.

Catalogs Panel Binder or Thumbnail ListBinder Filter
Binder TableRefresh Binder
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In the web client (see below), use the Filter menu (directly above the Binder Details 
panel) to help you filter binders. To return to an unfiltered list and display all binders, 
click the Filter icon again. 

3. Select a binder. When a binder is selected, Workflow Portal display its contents in 
the Binder Details panel directly below the Catalogs panel.

Using Binder Table Controls
The Binder table supports the following features:

Filtering

Type text in the Filter field or select a previously-entered string from the menu to filter 
the binders in the currently-selected catalog. Delete the text to display all binders in the 
catalog.

Sorting and Re-arranging Columns

Click on any column heading to sort the binder list, and click repeatedly to toggle the 
sort by ascending or descending order. Drag column headings to re-arrange the order.

Playing/Pausing Video

If enabled in the configuration, you can click the Play/Pause button in a binder row to 
preview the media. Click Repeatedly to play or pause the video. (Windows client only; 
the web client excludes this feature.)
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Submitting a Binder

If enabled in the configuration, you can click the Submit button to display the Submit 
Jobs window.

Details/Thumbnails View

Select Details or Thumbnails from the menu.
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Previewing Proxy Media in the Media Player
When you select a binder, Workflow Portal displays any file nicknamed Vantage Proxy in 
the media player, provided that it is encoded in a supported format. The binder 
contents may or may not display (above the media player), depending on the 
configuration.

Note: Some configurations allow you to perform tasks and access player controls that 
other configurations do not. This topic discusses the full functionality of the media 
player, not all of which may be visible in your current configuration.

The following topics describe how to preview media:

■ Previewing Proxy Media in the Windows Client

■ Previewing Proxy Media in the Web Client

■ Previewing Non-proxy Media

Previewing Proxy Media in the Windows Client
When you preview proxy files in the Windows client, you are using the QuickTime 
Player. If you don’t have QuickTime Player installed, download and install the player on 
your Workflow Portal workstation before you can preview these MOV files.

When you select a binder, Workflow Portal displays any video file nicknamed Vantage 
Proxy, if present. You can use the window, keyboard, and mouse controls listed in 

Current Scrubber 
Location: 
Clock Time and 
Timecode Time

Open Folder
Open File
Expand Panel

Video frame

Audio meters (L/R)

Speaker and 
Volume
Player Buttons: 
Jump to Start
Bump Back
Play
Bump Forward
Jump to End

Scrubber & 
Timeline

Navigate to Segments (Tempo)

Clip Duration

Resizing Handle 

Binder File List 
(Select proxy file to 
play)

Timeline Expansion:
Reduce Scale 1/2
Center Timeline Slider
Double Scale
History Backward
History Forward

Navigate to Silence (Tempo)
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Window, Keyboard, and Mouse Controls to control playback. You can also preview 
other supported media in the binder.

Proxy Encoding Requirements

Use the Flip action configured with the QuickTime or MP4 encoder to create a proxy file for 
previewing/clipping in the Windows client version of Workflow Portal:

• For QuickTime 7.6.9: QuickTime encoder, H.264 video codec, AAC audio codec

• For QuickTime 7.7.6: MP4 encoder, x264 video codec, AAC audio codec. 

• Set the proxy frame rate and timecode notation to match the source media.

• Assign the nickname Vantage Proxy, which the media player automatically loads.

• Set SD proxies (4:3) to a suggested 640 x 480 frame size. 

• Set HD proxies (16:9) to a suggested 640 x 360 frame size. 

• For x264 Video:

– Set Video Profile to Baseline.

– Set Interlace Mode to Progressive.

– Set Video Bit Rate to 1,000,000 to 2,000,000 bits/second.

– Set the IDR placement to Forced Interval Only (disable scene detection) and set 
Force IDR Interval to 50% of the frame rate—if frame rate is 30, set IDR to 15. 

• Configure the QuickTime Movie or MP4 file container to generate a timecode track. 

• Set AAC audio to Stereo (for stereo audio meters).

Note: For Create EDL from Catalogs mode, EDL processing requires Program Stream 
or Transport Stream MPEG-2 video, which must be included in the binder with the 
nickname Vantage EDL. Vantage also supports for MXF DV, IMX, and XDCAM HD video 
formats. All assets in the EDL must have the same frame size and frame rate.

Basic Media Player Controls

The Media Player panel displays the video in the viewing panel. The Media Player panel 
is resizable horizontally and vertically; the media frame displays the proper aspect ratio 
in the available space. A Maximize button in the upper left corner expands the player to 
fill the portal or reduces it back to the lower left corner.

You can play sound or mute it, by clicking the speaker icon just to the left of the volume 
adjustment bar, and you can vary the volume by adjusting the volume slider. 

Audio meters display on the left and right, representing left and right channel stereo. 
When the video is playing (even when sound is muted) or as you scrub the media, the 
meters provide a visual clue representation of sound volume. The audio meters are 
designed to visually show the points of silence near where the operator is creating a 
new segment. In Tempo configurations, operators can use the Silence buttons to 
navigate to and choose points of silence to create a new segment, to avoid audio 
anomalies during the re-timing process.
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The scrubber and timeline below the display enables you to scrub the media; and the 
player buttons enable you to play, stop, bump forward and back, and go to the start 
and end of the clip. 

The two bottom center timecodes display the current scrubber location clock time 
(HH:MM:SS.SSS) and timecode time (HH:MM:SS:FF@FPS). The timecode at the bottom 
right of the display shows total duration of the clip (HH:MM:SS.SSS). 

Tick marks and coloring displayed on the timeline indicate mark in and mark out points 
and clip segments. (In Tempo only, overlapping segments are highlighted in red to 
indicate that operator adjustment is required.)

Timeline Expansion Controls

Timeline expansion controls above the scrubber enable finer control of longer projects 
by expanding the length of the timeline. These controls are enabled and disabled by 
selecting or deselecting Options > Enable Preview Player Timeline Expansion.

The + and - buttons allow you to double or halve the timeline length with each press, 
and the tool tip for each control shows how much expansion has been applied.

When the timeline is expanded, a new slider below it controls which portion of the 
expanded timeline is visible. The C button centers the timeline slider. The two arrow 
buttons enable you to move backward and forward in timeline history. 

Note that the timeline automatically scrolls or centers the timeline when you perform 
actions on a part of the timeline that is not currently visible. 
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Window, Keyboard, and Mouse Controls
The Windows client window, keyboard, and mouse controls are listed in Window, 
Keyboard, and Mouse Controls.

Note: Clicking in the playback controls area or on the video focuses the preview 
player controls (indicated by the blue border). Focusing this area enables “JKL” controls 
instead of the shortcuts.

Function Controls

Play/Pause/Reverse Ctrl+P or Ctrl+Space

J (Reverse play—repeat for -1.5x, -2x, -5x, -8x)

K (Pause)

L (Play—repeat for 1.5x, 2x, 5x, 8x)

JK simultaneously (Reverse play slow motion -1/8x; repeat for 
-1/4x, -1/2x)

KL simultaneously (Forward play slow motion 1/8x; repeat for 
1/4x, 1/2x)

Stop Ctrl+S

Forward Frame Ctrl+F

Ctrl+Mouse Wheel, one frame per wheel click

K held down + L (Forward bump one frame)

L held down with K already pressed (Forward bump repeat 
1/4 speed)

Left Arrow (Reverse bump one frame)

Right Arrow (Forward bump one frame)

Forward/Reverse 10 
Frames

Up Arrow (Forward bump 10 frames)

Down Arrow (Reverse bump 10 frames)

Forward/Reverse 
One Second

Mouse Wheel (no modifier keys)—one second per wheel click

Forward/Reverse 
One Minute

Shift+Mouse Wheel—one minute per wheel click

Forward/Reverse 
One Hour

Ctrl+Shift+Mouse Wheel—one hour per wheel click; for video of 
less than an hour duration, jumps to beginning / end.
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Reverse Frame Ctrl+B

Ctrl+Mouse Wheel, one frame per wheel click

K+J (Reverse bump one frame)

k+J held down (Reverse bump repeat 
1/4 speed)

Mark In Ctrl+I or Ctrl+E (In points are indicated by tick marks on the 
timeline.)

Mark Out Ctrl+O or Ctrl+R

Go to mark in frame Ctrl+Q

Go to mark out 
frame

Ctrl+W

Go to start Ctrl+Home

Go to end Ctrl+End

Audio Mute (toggle) Ctrl+M 

Adjust Volume Drag volume button right or left to adjust volume.

Scroll media Drag media button right or left to scrub (scroll) media.

Duplicate selected 
clip

Ctrl+T (Selects the new, duplicated clip and sets its mark in to 
the original clip’s mark out, if appropriate)

Jump to next 
segment (only 
functional in multi-
segment video

Alt+Left | Right Arrow Jumps to the next or previous segment, 
as noted by the white bars on the scrubber bar. Works even 
when segment markers are not displayed. 

Jump to next scene 
change marker

Shift-Alt+Left | Right Arrow Jumps to the next or previous scene 
change marker, as noted by the green bars on the scrubber bar. 
Works even when scene change markers are not displayed. 

Function Controls
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Previewing Proxy Media in the Web Client
When you view proxy files in the Workflow Portal web client, you are utilizing the native 
HTML5 Video Player in the web browser.

Note: The appearance of captions in the proxy may vary, depending on the browser 
you’re using. Try supported browsers to find one that best suits your requirements.

Web Workflow Portal Proxy Encoding Requirements

Use the Flip action to produce a proxy file for previewing in the Workflow Portal web 
client’s HTML5 media viewer, using these settings:

• For QuickTime 7.6.9: QuickTime encoder, H.264 video codec, AAC audio codec

• For QuickTime 7.7.6: MP4 encoder, x264 video codec, AAC audio codec. 

• Set the proxy frame rate and timecode notation to match the source media.

• Assign the nickname Vantage Proxy, which the media player automatically loads.

• Set SD proxies (4:3) to a suggested 640 x 480 frame size. 

• Set HD proxies (16:9) to a suggested 640 x 360 frame size. 

• For x264 Video:

– Set Video Profile to Baseline.

– Set Interlace Mode to Progressive.

– Set Video Bit Rate to 1,000,000 to 2,000,000 bits/second.

– Set the IDR placement to Forced Interval Only (disable scene detection) and set 
Force IDR Interval to 50% of the frame rate—if frame rate is 30, set IDR to 15. 

• Configure the QuickTime Movie or MP4 file container to generate a timecode track. 

• Set AAC audio to Stereo (for stereo audio meters).
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Note: You can right-click on the video to display a context menu with many player 
commands as an alternative to using the player controls or keyboard shortcuts. The 
available controls vary with the browser.

To view a proxy, select a binder and use the controls in Web Workflow Portal Keyboard 
Controls to control playback. 

Previewing WebVTT Caption Files
Vantage can process media containing closed captions and produce a proxy media file 
and an accompanying WebVTT caption file. The proxy can be previewed with WebVTT 
captions using the HTML5 media player in Internet Explorer.

Note: Only Internet Explorer supports this playback feature. 

To create a proxy with WebVTT captions, follow these requirements in an ingest 
transcoding workflow:

• Use an Analyze action, with Ancillary Data Detection > Publish Metadata > Generate 
WebVTT Attachment implemented to create a WebVTT file. It must be nicknamed 
Vantage Caption Source. The file will be saved in a Vantage store.

• A newer alternative to creating a WebVTT file is the Timed Text Flip action. Specify 
the input media, caption, or subtitle file to decode; then specify a WebVTT output.

Note: An HTTP alias must be set up for the web portal. See Web Application Browser 
Requirements.

• Use a Flip action to transcode the file using the MP4 x264 encoder with closed cap-
tions enabled.

• Use a Register action to add the job (for accessing the proxy and the WebVTT files) 
in a catalog. 

• Display the proxy with captions in the Workflow Portal web applications’ media 
player. Be sure to set the player caption control in the gear menu to enable Closed 
Captions. 

Listening to Individual Audio Tracks
To listen to individual audio tracks in a proxy file using the web version of Workflow 
Portal, enable multiple audio streams in the Flip action (encoding MP4) that produces 
the Vantage Proxy nicknamed proxy file in the ingest workflow.

Note: Only Internet Explorer supports this playback feature. 
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Web Workflow Portal Keyboard Controls
The keyboard controls are dependent on the web browser (and the version) that you 
use. Most browsers provide fast forward, and some—such as Internet Explorer—
provide reverse as well. Workflow Portal’s playback rates aren’t generally implemented 
in every step—usually only x2 and x8 are supported. 

Note: The HTML5 Video Viewer must be in focus (you must click in the video frame) in 
order to use the player controls and keyboard shortcuts.

Function Controls

Play

Enabled in play mode (click 
Play button or press K key).

  (appears in binder list)

Press L x 1—play 1x speed (normal).
Press L x 2—play 2x speed.
Press L x 3—play 3x speed.
Press L x 4—play 5x speed.
Press L x 5—play 8x speed.

(IE only) Tap the + (plus) key to accelerate the clip’s play 
speed to the next level. Press the - (minus) key to 
decelerate the clip’s play speed down the next level.

Reverse Play

Enabled in play mode (click 
Play button or press K key).

 

Press J x—reverse play.
Press J x 2—reverse play 2x speed.
Press J x 3—reverse play 3x speed.
Press J x 4—reverse play 5x speed.
Press J x 5—reverse play 8x speed.

(IE only) Press the + (plus) key to accelerate the clip’s play 
speed up to the next level. Press the - (minus) key to 
decelerate the clip’s play speed down the next level. 

Play/Pause

Press K—play forward or pause. Hold K down to step in 
reverse. 

Forward Frames

Press L—step forward one frame.

(IE only) Press the Right Arrow key—move forward 10 
frames. 

(Chrome and IE 11) Press the Right Arrow key—move 
forward 1 frame. Press the Up Arrow key to move forward 
10 frames. 

The arrow keys on the numbers keypad function in the 
same manner.
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Reverse Frames  

Tap J—move reverse one frame.

(IE only) Press the Left Arrow key—move reverse 10 
frames. 

(Chrome and IE 11) Press the Left Arrow key—move 
reverse 1 frame. Press the Down Arrow key to move 
reverse 10 frames. 

The arrow keys on the numbers keypad function in the 
same manner.

Go to start

(IE only) Press the Home key.

Go to end

(IE only) Press the End key.

Mute audio

(IE only) Press the M key during play. Press again to 
unmute.

Scroll media  

Full screen mode

Press this button to expand to full screen mode.

Zoom mode (IE 11 only) Press Z to zoom in. Press Z again to zoom back 
out. 

Video-safe overlay  

Click to display/hide the video safe overlay frame, for SD 
and HD proxies. 

Closed captioning  

Click to display closed captions, when provided by 
browser.

Audio track menu

When multiple audio tracks are present, the Audio menu 
displays. Click to select the track you want to hear. (IE only).

Function Controls
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Previewing Non-proxy Media

Note: This feature is only supported in the Windows client and only when the binder 
detail display is enabled in the configuration.

Media with a nickname other than Vantage Proxy may be played under certain 
conditions. Select the media in the binder list (directly above the media player) and try 
these methods:

1. For QuickTime (.mov) files, select the file and use the media player controls to play 
the media file.

2. To play a QuickTime file outside the embedded media player, right-click the media 
and select Open With Default Program or click the file icon directly above the 
binder list to play the media file in the default program for MOV files.

3. If you don’t have a default program assigned to handle MOV files, right-click the 
media asset, and select Open Containing Folder or click the folder icon directly 
above the binder list. The Windows folder containing the media opens, so you can 
right-click the file and play it using Open With to select a suitable program.

4. For files other than QuickTime, right-click the media and select Open With Default 
Program or click the file icon directly above the binder list to play the media file in 
the default program for the specified suffix of the file.

5. If you don’t have a default program assigned to play this file type, right-click the 
media asset, and select Open Containing Folder or click the folder icon directly 
above the binder list. The Windows folder containing the media opens, so you can 
right-click the file and play it using Open With to select a suitable program.

Previewing Media in Switch
You can purchase and install Telestream’s Switch video player as an alternative to the 
Workflow Portal preview player in portal configurations that support Switch. When 
available, Workflow Portal displays the Switch logo in the preview player toolbar. Click 
the logo to open the selected clip in Switch. See the Switch User’s Guide for installation 
and operation details.
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Creating Clip Lists/Segments

Note: Microsoft User Account Control, by default, prevents Windows programs (such 
as the Workflow Portal client program) from writing files in certain protected folders. If 
you receive an error message indicating that access to a particular Vantage store or 
folder is denied, contact your Vantage administrator. Solutions include changing the 
location of the store/folder or disabling UAC on computers running Vantage clients.

Configurations that support clip/segment lists display a clip or segment management 
tab in the workspace (this tab differs, depending on the configuration):

To create a clip/segment list, do the following:

1. Browse the binders in the selected catalog, and select a binder to display its proxy 
in the media player.

2. Display the clip management tab (named Create EDL | Create CML | Create Parts | 
Segment List, depending on the configuration), and use the following topics to 
create and configure clips/segments:

■ Adding Clips

■ Evaluating Clip Metadata and Attributes

■ Editing Clip Start and End Times

■ Updating Segment Attributes in VOD/DAI Configurations

■ Updating a Selected Segment and Configuration

■ Deleting Clips

■ Reordering Clips
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Adding Clips
You can add multiple clips to a list, and you can add the same clip multiple times. 

Note: If you do not want to combine clips in one file, you can clip the same file 
multiple times. For example, if you are extracting multiple highlights from a single 
media file, you can mark a highlight, select Submit, and then mark a new highlight 
without affecting the first one.

To add a clip to the list from the media in the selected binder, click the Add button , 
or drag the binder to the list.

Note: EDL/Segment List clips must have the same frame size and frame rate. In a CML 
configuration, this is not a requirement. When you add the first clip to an EDL, the 
frame size and rate of the EDL are set to the metrics of that clip. Once the frame size 
and rate are set for a list, Workflow Portal does not allow you to add an incompatible 
clip. If you select a binder with a clip that is incompatible, the Add button is disabled to 
indicate that the clip cannot be added.

Each clip you add creates a tick mark on the timeline where the Mark In point is located.

Evaluating Clip Metadata and Attributes
When you select a clip, Workflow Portal displays the clip details to the right. The 
information may include the frame size and the frame rate, as well as other information 
about the selected clip, depending on the configuration.

Editing Clip Start and End Times
The default clip start and end times are the start and end times defined in the source 
media file. To trim the clip, edit the start and end times to define the clip you want.

To change the clip start time do any of the following:

• Use the media player to scrub to the start time and frame, then click the Mark In 
button to set the mark in time.

• Click in the Mark In time setting and press Ctrl+M.

• Type time or frame values in the Mark In time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark In time setting, click one of the numbers and use the up and down con-
trols to change the value.

To change the clip end time do any of the following:

• Use the media player to scrub to the end time and frame, then click the Mark Out 
button to set the mark out time.

• Click in the Mark Out time setting and press Ctrl+M.
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• Type time or frame values in the Mark Out time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark Out time setting, click one of the numbers and use the up and down 
controls to change the value.

• Adjust the duration timecode, which adjusts the mark out point relative to the mark 
in point. This field indicates the duration of the media between the mark in/out 
points of the currently selected clip.

If you specify a mark in, mark out, or duration timecode that makes one or more of the 
timecodes invalid, the affected timecodes display a red background. For example if you 
select a Mark In timecode that starts after the Mark Out timecode, the Mark In and 
Duration timecodes display red. Also, if the duration timecode moves the mark out 
timecode beyond the end of the clip timeline, both the Duration and Mark Out fields 
display red to indicate the error.

The duration timecode can be dropframe or non-dropframe, depending on the setting 
of the Use dropframe notation for duration when appropriate checkbox in the Vantage 
Management Console Workflow Portal Configurations panel. By default (unchecked), 
durations are always shown in non-dropframe. When checked, durations match the 
dropframe setting of the in/out values. (The Web Workflow Portal uses non-dropframe 
notation only.)

Updating Segment Attributes in VOD/DAI Configurations
VOD/DAI configurations include Segment Metadata which is adapted for ad insertion. 

A check box allows the rating graphic to be inserted into the selected segment. Details 
for the rating graphic are specified in the Vantage Management Console VOD/DAI 
Portal configuration Graphic Settings tab. These details include the graphic file to use, 
its screen location, duration on the screen, and other attributes, 

An SCC caption file can be included for each segment by browsing for the file.

An Ad insertion selection specifies the segment type:

Segment—This segment is marked for replacement by a dynamically inserted 
advertisement.

Head—This segment follows a dynamically inserted advertisement.

OTT—This segment consists of content to be delivered over-the-top (streamed).

None—This segment is program content or other content not designated for 
replacement by an ad (the default).

A Descriptor for Segment and Head can be selected to put ad breaks into the correct 
locations in the Canoe CSV report—at lead black, pre-roll, mid-roll, or post-roll. See the 
Post Producer Developer’s Guide for rules governing these selections.

CML Configuration settings (in CML and DPP Portals) allow you to specify an Output 
File Name for the completed project, indicates the approximate duration of the entire 
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project, and allows you to choose to unjoin segments that were joined previously using 
the portal.

Updating a Selected Segment and Configuration
For some portals types, such as Logging, a selected segment displays and allows you to 
edit segment and configuration details. These details vary by portal:

Mark In—The time marked in using the portal player.

Mark Out—The time marked out using the portal player.

Duration—The segment duration (difference between mark in and mark out).

Name—Segment name.

Description—Segment description.

Type—Segment type (a descriptive term selected from a list created in the Vantage 
Management Console).

Attachment Name—The XML clip list attachment generated by the portal and 
read by the target workflow. The default name for logging is [clip name]_DATA.

CML Name—(in CML and DPP Portals) The CML clip list name attachment for log-
ging is [clip name]_CML.

Job Name—A name you choose for the job. The default is the clip name.

In some portals you can also check Not Included to exclude a segment from the output. 
When a segment doesn’t match the type or the Not Included template setting, the clip 
is marked with a badge to alert you of the inconsistency, which may indicate a problem.

You can also modify the base name of the output files (an updated mezzanine 
metadata file and a CML file), and create a new template using the current segment 
configuration.

The configuration panel also includes segment cropping values for both the preview 
and Switch players. The Switch player’s values can be assigned to variables.

Reordering Clips
To change the order of a clip in the list, click on the clip and click the up  and down  
buttons, or click and drag the clips, to change the clip position.

Joining (Merging) and Unjoining (Splitting) Clips
Some configurations include a Join/Merge button  that allows you to join or combine 
two or more clips selected by Ctrl+clicking. When joined, the clips become one clip. To 
unjoin (split) clips and separate them again into individual segments, select Unjoin/Split 
button .

Deleting Clips
To delete a clip from the list, click on the clip and click the Delete button .
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Editing Metadata Labels
When the Workflow Portal configuration permits it, you can view and update the 
metadata labels ingested, produced, updated, or passed through previous workflows. 

Note: In a Forward Binder configuration, you edit metadata before submitting the 
binder to a publishing workflow. Changes are made in the binder you selected in the 
catalog. 

In a Copy Binder and Logging configurations, you click Submit and then enter 
metadata for the new binder you are creating. Your edits do not affect the original 
binder you selected from the catalog—only the new, copied binder.

In a VOD/DAI configuration, a Metadata Label source clip check box specifies which clip 
should be used as the source for metadata labels. The Metadata Labels tab then shows 
the labels associated with the selected clip.

When you submit a binder, all metadata labels are included. If the configuration 
supports metadata entry and editing, you can modify metadata labels before you 
submit. All metadata labels are applied to all media files that are being submitted.

The following topics describe how to edit metadata labels:

■ Editing Metadata in the Windows Client

■ Editing Metadata in the Web Client

Editing Metadata in the Windows Client
If the configuration supports metadata editing, you can edit them as follows:

1. Display the Metadata Labels tab.

2. Select the label you want to edit in the Metadata Label list.

3. In the Parameter list to the right, edit the parameter values. 
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4. If the metadata label you want to configure does not display in the list and the 
configuration permits adding labels, click the new label button, select a label to 
add, and click OK.

Note: This option is not available when submitting files in a Browse Windows 
Network configuration.

Editing Timecode Values with Hot Keys

If hot keys are assigned to input, output, or duration parameters in this configuration, 
you can use them to set these values as you scrub the media in the player. Roll over the 
mark button to display the assigned hot key in the tool tip.

Editing Timecode Values in Trim Groups

If trim groups are defined (a set of input, output, and duration parameters) in this 
configuration, the duration is automatically calculated. If you change the input value or 
output value, duration is automatically updated. If you change the duration value, the 
output value is automatically updated.

The duration timecode can be dropframe or non-dropframe, depending on the setting 
of the Use dropframe notation for duration when appropriate checkbox in the Vantage 
Management Console Workflow Portal Configurations panel. By default (unchecked), 
durations are always shown in non-dropframe. When checked, durations match the 
dropframe setting of the in/out values.
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Editing Metadata in the Web Client
If the configuration supports metadata editing, you can configure them as follows:

1. Initiate submit mode as described in Submitting Jobs in the Web Client.

2. To add a metadata label to configure, do the following:

a. Click Add Label.
b. Select a label to add from the Add Metadata Labels dialog.
c. Click Add.

3. To edit metadata label parameters, locate the tab for the label, select the tab, and 
configure the label parameters.

Note: If a label parameter includes a valid URL, an Open button automatically appears 
next to the parameter, allowing you to open to that URL by clicking the button.

4. To remove a metadata label configuration, locate the tab for the label, select the 
tab, and click Remove Label.

5. Repeat metadata label selection and parameter configuration until all required 
metadata labels are configured.

6. If you need to configure variables, see Specifying Variable Values.

7. When you are done preparing for submission, click Submit.
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Specifying Variable Values
You can set up Workflow Portal configuration to enable you to review and edit/add 
variable values stored in a binder from a previous job, before you submit the media 
(and the variables) to a publishing workflow.

Note: In Forward Binder configurations, you can edit variables in the main window; in 
Copy Binder configurations, you can only edit variables after you click the Submit 
button, in the Submit Jobs window. For details, see Browse Catalogs Copy Binder and 
Forward Binder Configurations.

To edit run-time variable values, display the Variables tab on the main window or the 
Submit Jobs window (depending on the type of configuration):

For each variable displayed, enter or update the run-time value as required.

Specifying Forwarding Workflows
Depending on your configuration setup, you may or may not be able to specify which 
workflow to submit jobs to:

• One or more workflows have been set as required in the configuration, and they are 
displayed as checked and disabled.

• One or more workflows have been set as required in the configuration, but the 
workflows list is hidden.

• One or more workflows are displayed; you can check those that you want to pro-
cess this job. If this is the case, the Forward to Workflows panel displays:

Check the workflows you want to submit this job to and click Submit. (These workflows 
must be activated in Workflow Designer, or your jobs will fail to run.)

For details on submitted jobs, see Submitting Jobs in the Windows Client or Submitting 
Jobs in the Web Client.
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Submitting Jobs in the Windows Client
When you click Submit, depending on the Workflow Portal configuration you are using, 
you may or may not have performed the following tasks at this point in the process:

■ Previewing Proxy Media in the Media Player

■ Editing Metadata Labels

■ Specifying Variable Values

■ Specifying Forwarding Workflows

For each of these tasks (which must be performed before you can submit the media to 
the publishing workflow for processing), the associated panel is displayed.

Click the link above to display the help topic for the task you are performing.

Submitting Jobs in the Web Client
When you initiate job submission in the web client, the Workflow Portal view changes 
from displaying media information to submitting information. 

The Workflow Portal configuration may specify one or more required workflows, or you 
may be able to select one or more workflows from a list. Some of these options are 
limited to a particular configuration, and some of them can be disabled. The options 
that apply to your environment are defined by the Vantage domain administrator and 
the workflow designer.

If the selected configuration allows you to view the workflows to which you can submit, 
Workflow Portal displays a Forward to Workflow tab. If the configuration does not 
support operator viewing of workflows, Workflow Portal just displays a Submit button.

To initiate submit mode, do the following:

1. If the Workflow Portal window displays a Forward to Workflows tab, do the 
following:

a. Select the Forward to Workflow tab.
b. Check or clear each workflow checkbox to specify which publishing workflows 

should process the job.
c. Click Submit to enter submit mode.

2. If Workflow Portal does not display a Forward to Workflows tab, do one of the 
following to initiate submit mode:

– Click the Submit button.

– Click the submit button  to the right of the binder name in the binder list.

If no other configuration options are available, the binder is submitted to the 
selected workflows.

3. If other configuration settings are available, Workflow Portal displays a dialog in 
which you can configure those options. For more information, refer to Editing 
Metadata Labels and Specifying Variable Values.

4. When you are done preparing for submission, click Submit.
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Windows Client Menus
This table describes the menu selections in the Workflow Portal Windows client.

Menu Selection Description

File Change Vantage Domain Enables you to log into another Vantage 
domain. See Selecting Vantage Domains and 
Logging In.

Change Vantage User Enables you to change Vantage users. See 
Changing Vantage Users in Windows Client 
Programs.

Recent Domains Lists the last few Vantage domains that 
were used in this client.

Change/Reload 
Application Configuration

Enables you to select another 
configuration, or reload a configuration 
that has been modified to pick up the 
changes. See Changing or Reloading a 
Configuration.

New Project Resets the Workflow Portal configuration to 
a new state, clearing all media and data in 
all tabs. See Creating a New Project.

Open Project Opens a project that was previously saved 
so that you can continue working or submit 
a job. See Opening a Project.

Save Project Saves the project in its current state—
media you’ve selected, and all data you’ve 
entered or set, for future use. See Saving a 
Project.

Save Project As... Saves the current project under another 
name, replicating the media and data and 
settings as another project. See Saving a 
Project With Another Name.

Exit Closes the Workflow Portal program.

Options Restore Tips & Warnings Restores the display of Workflow Portal tips 
and warnings after the feature has been 
disabled.

Hide Tips & Warnings Hides Workflow Portal tips and warnings.
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Use Clip Start Time Toggle this feature. When a check displays, 
the preview window uses the start time 
defined in the proxy media. If no check 
displays, the start time begins at zero.

Help Contents Display a Windows help version of this 
guide.

Index Display the index of this guide.

Search Search for key words in this guide.

Online Help Display the Vantage guides available on the 
Telestream web site.

About Display the Workflow Portal version 
information.

Menu Selection Description
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Web Client Menus
This table describes the menu selections and title bar options in the web clients.

Menu Selection Description

Title bar 
options

Change Password See Changing Passwords in Windows Client 
Programs.

Logout Log out the current Vantage user.

Change Domain See Selecting Vantage Domains and Logging 
In.

Catalogs 
menu

Refresh Catalog Listings Click to refresh the display of catalogs.

Help 
menu

About Select to display Workflow Portal product 
version information.

Help Documentation Click this entry to toggle the display of the 
submenu.

User Guide Click to display the PDF version of this 
guide in a separate browser window.

Web Help Click to display the HTML version of this 
guide in a separate browser window.
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Troubleshooting Workflow Portal
Use the following topics to help you solve certain problems with Workflow Portal:

■ Opening Workflow Portal the First Time

■ Difficulties Changing Configurations

■ Problems Playing Proxy Files

■ Configurations Don’t Display in the Web Client

■ No Session Licenses Available

Note: For customer service, see Contacting Telestream. You may use the Data 
Collection Utility (Vantage Management Console > Support Utilities > Data Collection). 
You may also use the Change Log or Error Log utilities to provide information during 
your service call.

Opening Workflow Portal the First Time
When opening Workflow Portal for the first time, depending on the design of your 
network and the location of your client workstation and Vantage domain server, the 
Domain login dialog may not display your Vantage domain. If this is the case, you may 
be able to log in by using the name or IP address of the Vantage domain server. For 
more details, see Selecting Vantage Domains and Logging In.

Difficulties Changing Configurations
When you change domains or configurations, you may also encounter these problems:

• No Configurations Available...

Workflow Portal displays this error when you log in to a domain where no Workflow 
Portal configurations are defined or where you do not have access to any of the 
defined configurations.

Contact your Vantage domain administrator.

• No session licenses available for this application...

Either the domain is not licensed for running Workflow Portal or all available Work-
flow Portal licenses are in use. Workflow Portal will operate in unlicensed/demo 
mode, but will not allow you to submit jobs or edit metadata labels until a Work-
flow Portal license becomes available.

Contact your Vantage domain administrator.

Note: An administrator can release a license in the Vantage Management Console.
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• Problem communicating with database—could not find stored procedure Select-
SessionsByExecution...

This error displays when Workflow Portal is attempting to display a list of configura-
tions from the selected domain, but the version of the domain is not compatible 
with your client. Contact your Vantage domain administrator to upgrade the Work-
flow Portal program on your computer.

• The requested workflows are either not running or no longer exist...

This error displays when you submit an asset or media file to a workflow that has 
been deleted, or is not activated. Contact your Vantage domain administrator, who 
can activate the Vantage workflow or edit the configuration to correct the problem.

Problems Playing Proxy Files
If you can’t play proxy files in a binder, review these issues:

– In the web client, the Wait cursor displays forever: 
Your virtual directory may not be implemented in IIS

– The location path may not be specified correctly, or it may be using a letter drive 
where a UNC path is required for remote client/service access

– The alias to the directory may not be specified in the store

– The alias path may be incorrect.

It is valid to use a drive letter as part of a Virtual Directory. This imposes no restric-
tions other than requiring the Vantage store to be located on a drive attached to 
the web apps host (such as a local hard drive or more commonly a SAN).

• In Workflow Portal, make sure that you create a QuickTime H.264/AAC proxy for 
previewing media or creating clips. Use the QuickTime encoder, and configure the 
container settings to generate a timecode track. Make sure that your encoded 
proxy file is the same frame rate and timecode notation as your production media. 
Assign the nickname Vantage Proxy, so that the media player in Workflow Portal 
automatically loads and displays your proxy. 

• Alternatively, the Workflow Portal Windows Client Media Player supports MP4 with 
x264-encoded H.264/AAC, provided that QuickTime 7.7.6 or later is installed on the 
computer running the Workflow Portal Windows client. 

• For previewing media in the Workflow Portal web client’s HTML5 media viewer, 
make sure the video is encoded using the Flip action (and nicknamed Vantage 
Proxy), with these settings:

Encoder: MP4 Encoder

Video Codec: x264

Audio Codec: AAC

Container: MP4 File

• Previewing EDL clips and working with them in the Create EDL clip list requires an 
MPEG-2 file nicknamed Vantage EDL. If an EDL catalog does not display a binder, 
the absence of a Vantage EDL file in the binder may be the cause.
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• When using the Workflow Portal Web Application on a Windows Server platform, 
you must install the Desktop Experience feature in order to view proxy media in the 
HTML5 Media Player.

• When playing to the end of a proxy in Chrome, versions 35 and 36, Telestream has 
observed that the media player may display an incorrect duration as a result of a 
round-up error. This anomaly is cosmetic. If you set this frame as a mark-out point, 
the correct timecode is entered by Workflow Portal.

Configurations Don’t Display in the Web Client
You’ve created a new configuration, but you can’t select it in the web Workflow Portal.

•  Perhaps it is not a Copy Binder or Forward Binder configuration— the other types 
are not designed to function in the web client, only the Windows client.

• Perhaps you (your Vantage user) don’t have permission to use it.

No Session Licenses Available
Workflow Portal displays this message when the number of active session licenses is 
equal to the number of authorized seats in your license, and no more are available.

Note: Open the Vantage Management Console > Licenses and use the Licenses and 
Portal Sessions tabs to determine how many servers can run Workflow Portal 
concurrently, and how many sessions are currently active.

Identify the reason and resolution:

•  The maximum number of operators are concurrently using Workflow Portal. Either 
increase the number of authorized servers (concurrent instances) or wait until 
someone closes Workflow Portal and releases a license. Open the Vantage Manage-
ment Console > Licenses and display the Licenses tab to review your license.

• Workflow Portal has crashed one or more times, and the session is still active even 
though that instance of Workflow Portal is not. Open the Vantage Management 
Console > Licenses and display the Portal Sessions tab to verify each active session 
and the associated computer. If Workflow Portal is not running on that server, select 
and delete the session to release it.
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